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Introduction

This section first verifies proper frame equipage. This includes verifying
module placement, jumper, and dual in–line package (DIP) switch
settings against the site-specific documentation supplied for each BTS
application. Next, pre-power up and initial power-up procedures are
presented.

Cell Site Types

Sites are configured as Omni with a maximum of 4 carriers, 3–sectored
with a maximum of 4 carriers, and 6–sectored with a maximum of 2
carriers. Each type has unique characteristics and must be optimized
accordingly. For more information on the differences in site types, please
refer to the BTS/Modem Frame Hardware Installation manual.

CDF

The Cell-site Data File (CDF) contains site type and equipage data
information and passes it directly to the LMF during optimization. The
number of modem frames, C–CCP shelves, BBX boards, MCC boards
(per cage), and linear power amplifier assignments are some of the
equipage data included in the CDF.

Be sure that the correct bts–#.cdf and cbsc–#.cdf files are
used for the BTS. These should be the CDF files that are
provided for the BTS by the CBSC. Failure to use the
correct CDF files can cause system errors. Failure to use
the correct CDF files to log into a live (traffic carrying)
site can shut down the site.

IMPORTANT

*

Site Equipage Verification

Review the site documentation. Match the site engineering equipage data
to the actual boards and modules shipped to the site. Physically inspect
and verify the equipment provided for the BTS or Modem frame and
ancillary equipment frame.

Always wear a conductive, high impedance wrist strap
while handling any circuit card/module to prevent damage
by ESD. After removal, the card/module should be placed
on a conductive surface or back into the anti–static
shipping bag.

CAUTION

Initial Installation of
Boards/Modules

Follow the procedure in Table 2-1 to verify the initial installation of
boards/modules.

 . . . continued on next page
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Table 2-1: Initial Installation of Boards/Modules

Step Action

1 Refer to the site documentation and install all boards and modules into the appropriate shelves as
required. Verify they are NOT SEATED at this time.

NOTE
On 800 MHz systems, the Switch Card has a configuration switch that must match the site
configuration (see Figure 2-1).

2 As the actual site hardware is installed, record the serial number of each module on a “Serial Number
Checklist” in the site logbook.

Figure 2-1: Switch Card
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Setting Frame C–CCP Shelf
Configuration Switch

The backplane switch settings behind the fan module nearest the breaker
panel should be set as shown in Figure 2-2.

The switch setting must be verified and set before power is applied to the
BTS equipment.

Figure 2-2: Backplane DIP Switch Settings – SC 4812T

19
 m

m
 F

ilt
er

 P
an

el

P
ow

er
 S

up
pl

y

A
M

R
 / 

M
A

C
H

H
S

O

C
S

M

C
S

M

39
 m

m
 F

ilt
er

 P
an

el

A
M

R
 / 

M
A

C
H

G
LI

2
G

LI
2

M
C

C
24

–6
B

B
X

2–
1

B
B

X
2–

2
B

B
X

2–
3

B
B

X
2–

4
B

B
X

2–
5

B
B

X
2–

6
B

B
X

2–
R

S
w

itc
h

M
P

C
M

P
C

C
IO

B
B

X
2–

7
B

B
X

2–
8

B
B

X
2–

9
B

B
X

2–
10

B
B

X
2–

11
B

B
X

2–
12

M
C

C
24

–5
M

C
C

24
–4

M
C

C
24

–3
M

C
C

24
–2

M
C

C
24

–1

M
C

C
24

–1
2

M
C

C
24

–1
1

M
C

C
24

–1
0

M
C

C
24

–9
M

C
C

24
–8

M
C

C
24

–7

P
ow

er
 S

up
pl

y

P
ow

er
 S

up
pl

y

C
C

D
C

C
D

FAN
MODULE

PWR/ALM

REAR

FRONT

FAN
MODULE

PWR/ALM

REAR

FRONT

ON
OFF

SC 4812T C–CCP SHELF

FAN MODULE
REMOVED

STARTER
FRAME
SETTING

ON
OFF

EXPANSION
FRAME 1
SETTING

ON
OFF

EXPANSION
FRAME 2
SETTING

B
O

T
T

O
M

 / 
T

O
P

R
IG

H
T

 / 
LE

F
T

M
O

D
E

M
_F

R
A

M
E

_I
D

_1

M
O

D
E

M
_F

R
A

M
E

_I
D

_0

B
O

T
T

O
M

 / 
T

O
P

R
IG

H
T

 / 
LE

F
T

M
O

D
E

M
_F

R
A

M
E

_I
D

_1

M
O

D
E

M
_F

R
A

M
E

_I
D

_0

B
O

T
T

O
M

 / 
T

O
P

R
IG

H
T

 / 
LE

F
T

M
O

D
E

M
_F

R
A

M
E

_I
D

_1

M
O

D
E

M
_F

R
A

M
E

_I
D

_0

FW00151REF

2



Pre–Power–up Tests
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Objective

This procedure checks for any electrical short circuits and verifies the
operation and tolerances of the cellsite and BTS power supply units prior
to applying power for the first time.

Test Equipment

The following test equipment is required to complete the pre–power–up
tests:

� Digital Multimeter (DMM)

Always wear a conductive, high impedance wrist strap
while handling the any circuit card/module to prevent
damage by ESD.

CAUTION

Cabling Inspection

Using the site-specific documentation generated by Motorola Systems
Engineering, verify that the following cable systems are properly
connected:

� Receive RF cabling – up to 12 RX cables

� Transmit RF cabling – up to six TX cables

� GPS

� LFR

For positive power applications (+27 V):

� The positive power cable is red.

� The negative power cable (ground) is black.
For negative power applications (–48 V):

� The negative power cable is red or blue.

� The positive power cable (ground) is black.
In all cases, the black power cable is at ground potential.

IMPORTANT

*
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DC Power Pre-test (BTS Frame)
Before applying any power to the BTS frame, follow the procedure in
Table 2-2 while referring to Figure 2-3 and Figure 2-4 for  +27 V
systems or to Figure 2-5 and Figure 2-6 for –48 V systems to verify
there are no shorts in the BTS frame DC distribution system.

Table 2-2: DC Power Pre–test (BTS Frame)

Step Action

1 Physically verify that all DC power sources supplying power to the frame are OFF or disabled.

2 On each frame:

� Unseat all circuit boards (except CCD and CIO cards) in the C–CCP shelf and LPA shelves, but
leave them in their associated slots.

� Set C–CCP shelf breakers to the OFF position by pulling out power distribution breakers (labeled
C–CCP 1, 2, 3 on the +27 V BTS C–CCP power distribution panel and labeled POWER
1,4,5,2,6,7,3,8,9  on the –48 V C–CCP power distribution panel).

� Set LPA breakers to the OFF position by pulling out the LPA breakers (8 breakers, labeled 1A–1B
through 4C–4D – located on the C–CCP power distribution panel in the +27 V BTS or on the
power conversion shelf power distribution panel in the –48 V BTS).

3 Verify that the resistance from the power (+ or –) feed terminals with respect to the ground terminal on
the top of the frame measures > 500 Ω (see Figure 2-3).

� If reading is < 500 Ω, a short may exist somewhere in the DC distribution path supplied by the
breaker. Isolate the problem before proceeding. A reading > 3 MΩ could indicate an open (or
missing) bleeder resistor (installed across the filter capacitors behind the breaker panel).

4 Set the C–CCP (POWER) breakers to the ON position by pushing them IN one at a time. Repeat
Step 3 after turning on each breaker.

* IMPORTANT* IMPORTANT
If the ohmmeter stays at 0 Ω after inserting any board/module, a short probably exists in that
board/module. Replace the suspect board/module and repeat the test. If test still fails, isolate the
problem before proceeding.

5 Insert and lock the DC/DC converter modules for the C–CCP shelf and into their associated slots one
at a time. Repeat Step 3 after inserting each module.

� A typical response is that the ohmmeter steadily climbs in resistance as capacitors charge, finally
indicating approximately 500 Ω.

! CAUTION
Verify the correct power/converter modules by observing the locking/retracting tabs appear as follows:

–  (in +27 V BTS C–CCP shelf)

–  (in –48 V BTS C–CCP shelf)

 

STPN4045A
PWR CONV  CDMA RCVR

STPN4009
PWR CONV  CDMA RCVR

6 Insert and lock all remaining circuit boards and modules into their associated slots in the C–CCP shelf.
Repeat Step 3 after inserting and locking each board or module.

� A typical response is that the ohmmeter steadily climbs in resistance as capacitors charge, stopping
at approximately 500 Ω..

. . . continued on next page
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Table 2-2: DC Power Pre–test (BTS Frame)

Step Action

7 Set the LPA breakers ON by pushing them IN one at a time.
Repeat Step 3 after turning on each breaker.

� A typical response is that the ohmmeter will steadily climb in resistance as capacitors charge,
stopping at approximately 500 Ω..

8 In the –48 V BTS, insert and lock the DC/DC LPA converter modules into their associated slots one at
a time.
Repeat Step 3 after inserting each module.

� A typical response is that the ohmmeter steadily climbs in resistance as capacitors charge, finally
indicating approximately 500 Ω.

! CAUTION
Verify the correct power/converter modules by observing the locking/retracting tabs appear as follows:

–  (in –48 V BTS power conversion shelf)STPN4044A
PWR CONV  LPA

9 Seat all LPA and associated LPA fan modules into their associated slots in the shelves one at a time.
Repeat Step 3 after seating each LPA  and associated LPA fan module.

� A typical response is that the ohmmeter will steadily climb in resistance as capacitors charge,
stopping at approximately 500 Ω..
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Figure 2-3: +27 V BTS DC Distribution Pre-test
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Figure 2-4: +27 V SC 4812T BTS Starter Frame
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Figure 2-5: –48 V BTS DC Distribution Pre-test
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Figure 2-6: –48 V SC 4812T BTS Starter Frame
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DC Power Pre-test (RFDS)

Before applying power to the RFDS, follow the steps in Table 2-3, while
referring to Figure 2-7, to verify there are no shorts in the RFDS DC
distribution system, backplanes, or modules/boards. As of the date of
this publication, the RFDS is not used with the –48 V BTS.

Visual inspection of card placement and equipage for each
frame vs. site documentation must be completed, as
covered in Table 2-1, on page 2-2, before proceeding with
this test.

IMPORTANT

*

Table 2-3: DC Power Pre-test (RFDS)

Step Action

1 Physically verify that all DC/DC converters supplying the RFDS are OFF or disabled.

2 Set the input power rocker switch P1 to the OFF position (see Figure 2-7).

3 Verify the initial resistance from the power (+ or –) feed terminal with respect to ground terminal
measures > 5 kΩ , then slowly begins to increase.

� If the initial reading is < 5 kΩ and remains constant, a short exists somewhere in the DC
distribution path supplied by the breaker. Isolate the problem before proceeding.

4 Set the input power rocker switch P1 to the ON position.

Repeat Step 3.

Figure 2-7: DC Distribution Pre-test (COBRA RFDS Detail)

NOTE:
Set the input power switch ON while measuring the
resistance from the DC power –  with respect to the
power + terminal on the rear of the COBRA RFDS.

INPUT POWER
SWITCH (P1)

FRONT OF COBRA RFDS
(cut away view shown  for clarity)

RFDS REAR
INTERCONNECT PANEL

“–” CONNECTOR
PIN

“+” CONNECTOR
PIN

CONNECTOR (MADE
UP OF A HOUSING

AND TWO PINS)

FW00139
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Power-up Procedures

Potentially lethal voltage and current levels are routed to
the BTS equipment. This test must be performed with a
second person present, acting in a safety role. Remove all
rings, jewelry, and wrist watches prior to beginning this
test.

WARNING

DC Input Power

In the tests to follow, power will first be verified at the input to each
BTS frame. After power is verified, cards and modules within the frame
itself will be powered up and verified one at a time.

Before applying any power, verify the correct power feed and return
cables are connected between the power supply breakers and the power
connectors at the top of each BTS frame. Verify correct cable position
referring to Figure 2-3 on page 2-7 for +27 V systems and Figure 2-5 on
page 2-9 for –48 V systems.

Always wear a conductive, high impedance wrist strap
while handling any circuit card/module to prevent damage
by ESD. Extreme care should be taken during the removal
and installation of any card/module. After removal, the
card/module should be placed on a conductive surface or
back into the anti–static bag in which it was shipped.

CAUTION

For positive power applications (+27 V):

� The positive power cable is red.

� The negative power cable (ground) is black.
For negative power applications (–48 V):

� The negative power cable is red or blue.

� The positive power cable (ground) is black.
In all cases, the black power cable is at ground potential.

IMPORTANT

*

Motorola recommends that the DC input power cable used to connect the
frame to the main DC power source conforms to the guidelines outlined
in Table 2-4.

 . . . continued on next page
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Table 2-4: DC Input Power Cable Guidelines

Maximum Cable Length Wire Size

30.38 m (100 ft) 107 mm2 (AWG #4/0)

54.864 m (180 ft) 185 mm2 (350 kcmil)

Greater that 54.864 m (180 ft) Not recommended

* If Anderson SB350 style power connectors are used, make
sure the connector adapters are securely attached to each of
the BTS power feeds and returns. Also, make sure the
cables have been  properly installed into each connector.

IMPORTANT

Common Power Supply
Verification

The procedure in Table 2-5 must be performed on any BTS frame
connected to a common power supply at the site after the common power
supply has been installed and verified per the power supply OEM
suggested procedures.

Perform the following steps to verify the power input is within
specification before powering up the individual cards/modules with the
frames themselves.

Table 2-5: Common Power Supply Verification

Step Action

1 Physically verify that all DC power sources supplying the frame are OFF or disabled.

2 On the RFDS (for +27 V systems only), set the input power switch P1 to the OFF position (see
Figure 2-7).

3 On each frame:

� Unseat all circuit boards (except CCD and CIO cards) in the C–CCP shelf and LPA shelves, but
leave them in their associated slots.

� Set breakers to the OFF position by pulling out C–CCP and LPA breakers (see Figure 2-3 on
page 2-7 or Figure 2-5 on page 2-9 for breaker panel layout if required).

– C–CCP shelf breakers are labeled CCCP–1, 2, 3 in the +27 V BTS and labeled POWER
1,4,5,2,6,7,3,8,9  in the –48 V BTS.

– LPA breakers are labeled 1A–1B through 4C–4D.

4 Inspect input cables, verify correct input power polarity via decal on top of frame (+27 Vdc or
–48 Vdc).

5 Apply power to BTS frames, one at a time, by setting the appropriate breaker in the power supply that
supplies the frame to the ON position.

6 After power is applied to each frame, use a digital voltmeter to verify power supply output voltages at
the top of each BTS frame are within specifications: +27.0 Vdc or –48 Vdc nominal.

2
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Initial Power-up (RFDS)

The procedure in Table 2-6 must be performed on the RFDS after input
power from the common power supply has been verified. Perform the
following steps to apply initial power to the cards/modules within the
frame itself, verifying that each is operating within specification.

Visual inspection of card placement and equipage for each
frame vs. site documentation must be completed, as
covered in Table 2-1, on page 2-2, before proceeding with
this test.

IMPORTANT

*

Table 2-6: Initial Power-up (RFDS)

Step Action

1 On the RFDS, set the input power rocker switch (P1) to the ON position (see Figure 2-7).

2 Verify power supply output voltages (at the top of BTS frame), using a digital voltmeter, are within
specifications: +27.0 V nominal.

Initial Power-up (BTS)

The procedure must be performed on each frame after input power from
the common power supply has been verified. Follow the steps in
Table 2-7 to apply initial power to the cards/modules within the frame
itself, verifying that each is operating within specification.

Table 2-7: Initial Power–up (BTS)

Step Action

1 At the BTS, set the C–CCP (POWER) power distribution breakers (see Figure 2-3 on page 2-7 or
Figure 2-5 on page 2-9) to the ON position by pushing in the breakers.

2 Insert the C–CCP fan modules. Observe that the fan modules come on line.

3 ! CAUTION
Verify the correct power/converter modules by observing the locking/retracting tabs appear as follows:

– (in +27 V BTS C–CCP shelf)

– (in –48 V BTS C–CCP shelf)

– (in –48 V BTS power conversion shelf)

Insert and lock the converter/power supplies into their associated slots one at a time.
• If no boards have been inserted, all three PWR/ALM LEDs would indicate RED to notify the user

that there is no load on the power supplies.

– If the LED is RED, do not be alarmed. After Step 4 is performed, the LEDs should turn GREEN;
if not, then a faulty converter/power supply module is indicated and should be replaced before
proceeding.

STPN 4045A
PWR CONV  CDMA RCVR

STPN 4044A
PWR CONV  LPA

STPN4009
PWR CONV  CDMA RCVR

4 Seat and lock all remaining circuit cards and modules in the C–CCP shelf into their associated slots.

. . . continued on next page
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Table 2-7: Initial Power–up (BTS)

Step Action

5 Seat the first equipped LPA module pair into the assigned slot in the upper LPA shelf including LPA
fan.

� In +27 V systems, observe that the LPA internal fan comes on line.

6 Repeat step 5 for all remaining LPAs.

7 Set the LPA breakers to the ON position (per configuration) by pushing them IN one at a time. See
Figure 1-13 on page 1-30 or Figure 1-14 on page 1-31 for configurations and Figure 2-3 on page 2-7
or Figure 2-5 on page 2-9 for LPA breaker panel layout.

On +27 V frames, engage (push) LPA circuit breakers.

� Confirm LEDs on LPAs light.

On –48 V frames, engage (push) LPA PS circuit breakers.

� Confirm LPA PS fans start.

� Confirm LEDs on –48 V power converter boards light.

� Confirm LPA fans start.

� Confirm LEDs on LPAs light.

8 After all cards/modules have been seated and verified, use a digital voltmeter to verify power supply
output voltages at the top of the frame remain within specifications: +27.0 Vdc or –48 Vdc nominal.

9 Repeat Steps 1 through 8 for additional co–located frames (if equipped).
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Chapter 3: Optimization/Calibration
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Introduction

This section describes procedures for isolating the BTS from the span
lines, preparing and using the LMF, downloading system operating
software, CSM reference verification/optimization, set up and calibration
of the supported test equipment, transmit/receive path verification, using
the RFDS, and verifying the customer defined alarms and relay contacts
are functioning properly.

Before using the LMF, use an editor to view the
”CAVEATS” section in the ”readme.txt” file in the c:\wlmf
folder for any applicable information.

IMPORTANT

*

Optimization Process

After a BTS is physically installed and the preliminary operations
(power up) have been completed, the LMF is used to calibrate and
optimize the BTS. Motorola recommends that the optimization be
accomplished as follows:

1. Download MGLI2–1 with code and data and then enable MGLI2–1.

2. Use the status function and verify that all of the installed devices of
the following types respond with status information: CSM, BBX,
GLI2, MCC, and TSU (if RFDS is installed). If a device is installed
and powered up but is not responding and is colored gray in the BTS
display, the device is not listed in the CDF file. The CDF file will
have to be corrected before the device can be accessed by the LMF.

3. Download code and data to all devices of the following types:

– CSM

– BBX (may be BBX2 or BBX–1X)

– GLI2 (other than MGLI2–1)

– MCC (may be MCC–8E, MCC24, or MCC–1X)

4. Download the RFDS TSIC (if installed).

5. Verify the operation of the GPS and HSO signals.

6. Enable the following devices (in the order listed):

– Secondary CSM

– Primary CSM

– All MCCs

7. Connect the required test equipment for a full optimization.

8. Select the test equipment.

9. Calibrate the TX and RX test cables if they have not previously been
calibrated using the CDMA LMF that is going to be used for the
optimization/calibration. The cable calibration values can also be
entered manually.

 . . . continued on next page
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10. Select all of the BBXs and all of the MCCs, and use the full
optimization function. The full optimization function performs TX
calibration, BLO download, TX audit, all TX tests, and all RX tests
for all selected devices.

11. If the TX calibration fails, repeat the full optimization for any failed
paths.

12. If the TX calibration fails again, correct the problem that caused the
failure and repeat the full optimization for the failed path.

13. If the TX calibration and audit portion of the full optimization passes
for a path but some of the TX or RX tests fail, correct the problem
that caused the failure and run the individual tests as required until
all TX and RX tests have passed for all paths.

Cell Site Types

Sites are configured as Omni/Omni or Sector/Sector (TX/RX). Each type
has unique characteristics and must be optimized accordingly.

For more information on the differences in site types,
please refer to the applicable BTS/Modem Frame Hardware
Installation and Functional Hardware Description
manuals.

NOTE

Cell–Site Data File

The Cell–SiteData File (CDF) contains information that defines the BTS
and data used to download files to the devices. A CDF file must be
placed in the applicable BTS folder before the LMF can be used to log
into that BTS. CDF files are normally obtained from the CBSC using a
floppy disk. A file transfer protocol (ftp) method can be used if the LMF
computer has that capability.

 The CDF includes the following information:

� Download instructions and protocol

� Site specific equipage information

� C–CCP shelf allocation plan

– BBX equipage (based on cell–site type) including redundancy

– CSM equipage including redundancy

– MCC (MCC24E, MCC8E, or MCC–1X) channel element allocation
plan. This plan indicates how the C–CCP shelf is configured, and
how the paging, synchronization, traffic, and access channel
elements (and associated gain values) are assigned among the (up to
12) MCCs in the shelf.

� CSM equipage including redundancy

 . . . continued on next page
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� Effective Rated Power (ERP) table for all TX channels to antennas
respectively. Motorola System Engineering specifies the ERP of a
transmit antenna based on site geography, antenna placement, and
government regulations. Working from this ERP requirement, the
antenna gain, (dependent on the units of measurement specified) and
antenna feed line loss can be combined to determine the required
power at the top of the BTS frame. The corresponding BBX output
level required to achieve that power level on any channel/sector can
also be determined.

Refer to the CDMA LMF Operator’s Guide, 68P64114A78,
for additional information on the layout of the LMF
directory structure (including CDF file locations and
formats).

NOTE

BTS System Software
Download

BTS system software must be successfully downloaded to the BTS
processor boards before optimization can be performed. BTS operating
code is loaded from the LMF computer terminal.

Before using the LMF for optimization/ATP, the correct
bts–#.cdf and cbsc–#.cdf files for the BTS must be
obtained from the CBSC and put in a bts–# folder in the
LMF. Failure to use the correct CDF files can cause wrong
results. Failure to use the correct CDF files to log into a
live (traffic carrying) site can shut down the site.

IMPORTANT

*

The CDF is normally obtained from the CBSC on a DOS formatted
diskette, or through a file transfer protocol (ftp) if the LMF computer has
ftp capability. Refer to the CDMA LMF Operator’s Guide, or the LMF
Help screen, for the procedure.

Site Equipage Verification

If you have not already done so, use an editor to view the CDF, and
review the site documentation. Verify the site engineering equipage data
in the CDF matches the actual site hardware using a CDF conversion
table.

Always wear a conductive, high impedance wrist strap
while handling any circuit card/module to prevent damage
by ESD. Extreme care should be taken during the removal
and installation of any card/module. After removal, the
card/module should be placed on a conductive surface or
back into the anti–static bag in which it was shipped.

CAUTION
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Isolate BTS from T1/E1 Spans

At active sites, the OMC/CBSC must disable the BTS and
place it out of service (OOS). DO NOT remove the 50–pin
TELCO cable connected to the BTS frame site I/O board
J1 connector until the OMC/CBSC has disabled the BTS!

IMPORTANT

*

Each frame is equipped with one Site I/O and two Span I/O boards. The
Span I/O J1 connector provides connection of 25 pairs of wire. A GLI2
card can support up to six spans. In the SC 4812T configuration, the odd
spans (1, 3, and 5) terminate on the Span ”A” I/O; and the even spans (2,
4, and 6) terminate on the Span ”B” I/O.

Before connecting the LMF to the frame LAN, the OMC/CBSC must
disable the BTS and place it OOS to allow the LMF to control the
CDMA BTS. This prevents the CBSC from inadvertently sending
control information to the CDMA BTS during LMF based tests. Refer to
Figure 3-1 and Figure 3-2 as required.

Table 3-1: T1/E1 Span Isolation

Step Action

1 From the OMC/CBSC, disable the BTS and place it OOS. Refer to SC OMC–R/CBSC System
Operator Procedures.

– The T1/E1 span 50–pin TELCO cable connected to the BTS frame SPAN I/O board J1 connector
can be removed from both Span I/O boards, if equipped, to isolate the spans.

NOTE
If a third party is used for span connectivity, the third party must be informed before disconnecting the
span line.

* IMPORTANT
Verify that you remove the SPAN cable, not the “MODEM/TELCO” connector.
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Figure 3-1: Span I/O Board T1 Span Isolation
50–PIN TELCO
CONNECTORS
REMOVED

SPAN A CONNECTOR
(TELCO) INTERFACE
TO SPAN LINES

SPAN B CONNECTOR
(TELCO) INTERFACE
TO SPAN LINES

TOP of Frame
 (Site I/O and Span I/O boards)

RS–232 9–PIN SUB D
CONNECTOR SERIAL
PORT FOR EXTERNAL
DIAL UP MODEM
CONNECTION (IF USED)

FW00299

LMF to BTS Connection

The LMF is connected to the LAN A or B connector located on the left
side of the frame’s lower air intake grill, behind the LAN Cable Access
door (see Figure 3-2).

Table 3-2: LMF to BTS Connection

Step Action

1 To gain access to the connectors on the BTS, open the LAN Cable Access door, then pull apart the
Velcro  tape covering the BNC “T” connector (see Figure 3-2).

2 Connect the LMF to the LAN A BNC connector via PCMCIA Ethernet Adapter with an unshielded
twisted–pair (UTP) Adapter and 10BaseT/10Base2 converter (powered by an external AC/DC
transformer).

– If there is no login response, connect the LMF to the LAN B connector.

– If there is still no login response, see Table 6-1, Login Failure Troubleshooting Procedures.

NOTE
– Xircom Model PE3–10B2 or equivalent can also be used to interface the LMF Ethernet

connection to the frame connected to the PC parallel port, powered by an external AC/DC
transformer. In this case, the BNC cable must not exceed 91 cm (3 ft) in length.

* IMPORTANT
– The LAN shield is isolated from chassis ground. The LAN shield (exposed portion of BNC

connector) must not touch the chassis during optimization.
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Figure 3-2: LMF Connection Detail
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Overview

Software and files for installation and updating of the LMF are provided
on CD ROM disks. The following installation items must be available:

� LMF Program on CD ROM

� LMF Binaries on CD ROM

� CDF for each supported BTS (on diskette or available from the
CBSC)

� CBSC File for each supported BTS (on diskette or available from the
CBSC)

The following section provides information and instructions for
installing and updating the LMF software and files.

For the CDMA LMF graphics to display properly, the
computer platform must be configured to display more
than 256 colors. See the operating system software
instructions for verifying and configuring the display
settings.

IMPORTANT

*

LMF Operating System Installation

Follow the procedure in Table 3-3 to install the LMF operating system.

Table 3-3: LMF Operating System Installation

� Step Action

1 Insert the LMF Program CD ROM into the LMF CD ROM drive.

– If the Setup screen is displayed, go to step 5.

– If the Setup screen is not displayed, proceed to step 2.

2 Click on the Start button.

3 Select Run.

4 In the Open box, enter d:\autorun and click on the OK button.

NOTE
If applicable, replace the letter d with the correct CD ROM drive letter.

. . . continued on next page
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Table 3-3: LMF Operating System Installation

� ActionStep

5 Follow the instructions displayed on the Setup screen.

* IMPORTANT
First Time Installations:

– Install U/WIN (First)

– Install Java Runtime Environment (Second)

– Install LMF Software (Third)

– Install BTS Binaries (Fourth)

– Install/Create BTS Folders (Fifth)

Any time you install U/WIN, you must install the LMF software because the installation of the
LMF modifies some of the files that are installed during the U/Win installation. Installing U/Win
over–writes these modifications.

NOTE
There are multiple binary image packages for installation on the CD–ROM. When prompted,
choose the load that corresponds to the switch release that you currently have installed. Perform
the Device Images install after the WinLMF installation.

If applicable, a separate CD ROM of BTS Binaries may be available for binary updates.

 

Copy CDF Files from CBSC

Before the LMF can execute the optimization/ATP procedures for the
BTS, the correct bts-#.cdf and cbsc-#.cdf files must be
obtained from the CBSC and put in a bts-# folder in the LMF
notebook. This requires copying the CBSC CDF files to a DOS
formatted diskette, and using the diskette to install the CDF file in the
LMF.

Follow the procedure in Table 3-4 to obtain the CDF files from the
CBSC and copy the files to a diskette. For any further information, refer
to the CDMA LMF Operator’s Guide (Motorola part number
68P64114A78) or the LMF Help screen..

If the LMF has ftp capability, the ftp method can be used to
copy the CDF files from the CBSC.

On Sun OS workstations, the unix2dos command can be
used in place of the cp command (e.g., unix2dos
bts–248.cdf bts–248.cdf). This should be done using a
copy of the CBSC CDF file so the original CBSC CDF file
is not changed to DOS format.

NOTE

 . . . continued on next page
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* When copying CDF files, comply with the following to
prevent BTS login problems with the LMF:

– The numbers used in the bts–#.cdf and cbsc–#.cdf
filenames must correspond to the locally assigned numbers
for each BTS and its controlling CBSC.

– The generic cbsc–1.cdf file supplied with the LMF work
with locally numbered BTS CDF files. Using this file does
not provide a valid optimization unless the generic file is
edited to replace default parameters (e.g., channel numbers)
with the operational parameters used locally.

IMPORTANT

Table 3-4: Copying CBSC CDF Files to the LMF

� Step Action

AT THE CBSC:

1 Login to the CBSC workstation.

2 Insert a DOS formatted diskette in the workstation drive.

3 Type eject –q and press the <Enter> key.

4 Type mount and press the <Enter> key.

NOTE
� Look for the “floppy/no_name” message on the last line displayed.

� If the eject command was previously entered, floppy/no_name will be appended with a
number. Use the explicit floppy/no_name reference displayed when performing step 7.

5 Change to the directory containing the file by typing cd <directory name> (ex. cd
bts–248) and pressing <Enter>.

6 Type ls <Enter> to display the list of files in the directory.

7 With Solaris versions of Unix, create DOS–formatted versions of the bts–#.cdf and cbsc–#.cdf
files on the diskette by entering the following command:

unix2dos <source filename> /floppy/no_name/<target filename>
(e.g., unix2dos bts–248.cdf /floppy/no_name/bts–248.cdf).

NOTE
� Other versions of Unix do not support the unix2dos and dos2unix commands. In these cases,

use the Unix cp (copy) command. The copied files will be difficult to read with a DOS or
Windows text editor because Unix files do not contain line feed characters. Editing copied CDF
files on the LMF computer is, therefore, not recommended.

� Using cp, multiple files can be copied in one operation by separating each filename to be copied
with a space and ensuring the destination directory (floppy/no_name) is listed at the end of the
command string following a space (e.g., cp  bts–248.cdf cbsc–6.cdf /floppy/na_name).

. . . continued on next page
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Table 3-4: Copying CBSC CDF Files to the LMF

� ActionStep

8 Repeat steps 5 through 7 for each bts–# that must be supported by the LMF.

9 When all required files have been copied to the diskette, type eject and press the <Enter> key.

10 Remove the diskette from the CBSC.

AT THE LMF:

11 Start the Windows operating system.

12 Insert the diskette into the LMF.

13 Using Windows Explorer (or equivalent program), create a corresponding bts–# folder in the
wlmf\cdma directory for each bts–#.cdf/cbsc–#.cdf file pair copied from the CBSC.

14 Use Windows Explorer (or equivalent program) to transfer the cbsc–#.cdf and bts–#.cdf files from
the diskette to the corresponding wlmf\cdma\bts–# folders created in step 13.

 

Creating a Named
HyperTerminal Connection for
MMI Connection

Confirming or changing the configuration data of certain BTS Field
Replaceable Units (FRUs) requires establishing an MMI communication
session between the LMF and the FRU. Using features of the Windows
operating system, the connection properties for an MMI session can be
saved on the LMF computer as a named Windows HyperTerminal
connection. This eliminates the need for setting up connection
parameters each time an MMI session is required to support
optimization.

Once the named connection is saved, a shortcut for it can be created on
the Windows desktop. Double clicking the shortcut icon will start the
connection without the need to negotiate multiple menu levels.

Follow the procedure in Table 3-5 to establish a named HyperTerminal
connection and create a WIndows desktop shortcut for it.

There are differences between Windows NT and Windows
98 in the menus and screens for creating a HyperTerminal
connection. In the following procedure, items applicable
to:
– Windows NT will be identified with Win NT
– Windows 98 will be identified with Win 98

NOTE

 . . . continued on next page
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Table 3-5: Creating a Named Hyperlink Connection for MMI Connection

Step Action

1 From the Windows Start menu, select:

Programs>Accessories

2 Perform one of the following:

� For Win NT, select Hyperterminal and then click on HyperTerminal

� For Win 98, select Communications, double click the Hyperterminal folder, and then double click
on the Hyperterm.exe icon in the window that opens.

NOTE
� If a Location Information Window appears, enter the required information, then click  Close.

(This is required the first time, even if a modem is not to be used.)

� If a You need to install a modem..... message appears, click NO.

3 When the Connection Description box opens:

– Type a name for the connection being defined (e.g., MMI Session) in the Name: window.

– Highlight any icon preferred for the named connection in the Icon: chooser window.

– Click OK.

4

NOTE
For LMF configurations where COM1 is used by another interface such as test equipment and a
physical port is available for COM2, select COM2 to prevent conflicts.

From the Connect using: pick list in the Connect To box displayed, select the RS–232 port to be used
for the connection (e.g., COM1 or COM2 (Win NT) – or Direct to Com 1 or Direct to Com 2 (Win
98), and click OK.

5 In the Port Settings tab of the COM# Properties window displayed, configure the RS–232 port
settings as follows:

� Bits per second: 9600

� Data bits: 8

� Parity: None

� Stop bits: 1

� Flow control: None

6 Click OK.

7 Save the defined connection by selecting:

File>Save

8 Close the HyperTerminal window by selecting:

File>Exit

9 Click Yes to disconnect when prompted.

. . . continued on next page
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Table 3-5: Creating a Named Hyperlink Connection for MMI Connection

Step Action

10 Perform one of the following:

� If the Hyperterminal folder window is still open (Win 98) proceed to step 12

� From the Windows Start menu, select Programs > Accessories

11 Perform one of the following:

� For Win NT, select Hyperterminal and release any pressed mouse buttons.

� For Win 98, select Communications and double click the Hyperterminal folder.

12 Highlight the newly created connection icon by moving the cursor over it (Win NT) or clicking on it
(Win 98).

13 Right click and drag the highlighted connection icon to the Windows desktop and release the right
mouse button.

14 From the pop–up menu displayed, select Create Shortcut(s) Here.

15 If desired, reposition the shortcut icon for the new connection by dragging it to another location on the
Windows desktop.
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Folder Structure Overview

The LMF uses a wlmf folder that contains all of the essential data for
installing and maintaining the BTS. The list that follows outlines the
folder structure for the LMF. Except for the bts–nnn folders, these
folders are created as part of the the LMF installation. Refer to the
CDMA LMF Operator’s Guide for a complete description of the folder
structure.

Figure 3-3: LMF Folder Structure

version folder (A separate folder is
required for each different version; for
example, a folder name 2.8.1.1.1.5)

loads folder

(C:)

wlmf folder

cdma folder

code folder

data folder

BTS–nnn folders (A separate folder is
required for each BTS where bts–nnn is the
unique BTS number; for example, bts–163)
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Pinging the Processors

For proper operation, the integrity of the Ethernet LAN A and B links
must be be verified. Figure 3-4 represents a typical BTS Ethernet
configuration. The drawing depicts one (of two identical) links, A and B.

Ping is a program that routes request packets to the LAN network
modules to obtain a response from the specified “targeted” BTS.

Figure 3-4: BTS LAN Interconnect Diagram
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Follow the procedure in Table 3-6 and refer to Figure 3-5 or Figure 3-6,
as required, to ping each processor (on both LAN A and LAN B) and
verify LAN redundancy is operating correctly.

Always wear a conductive, high impedance wrist strap
while handling any circuit card/module to prevent damage
by ESD.

CAUTION

* The Ethernet LAN A and B cables must be installed on
each frame/enclosure before performing this test. All other
processor board LAN connections are made via the
backplanes.

IMPORTANT

 . . . continued on next page
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Table 3-6: Pinging the Processors

� Step Action

1 If you have not already done so, connect the LMF to the BTS (see Table 3-2 on page 3-5).

2 From the Windows desktop, click the Start button and select Run.

3 In the Open box, type ping and the <MGLI IP address> (for example, ping 128.0.0.2).

NOTE
128.0.0.2 is the default IP address for MGLI–1 in field BTS units. 128.0.0.1 is the default IP address
for MGLI–2.

4 Click on the OK button.

5 If the connection is successful, text similar to the following is displayed:

Reply from 128 128.0.0.2: bytes=32 time=3ms TTL=255

If there is no response the following is displayed:

Request timed out

If the MGLI fails to respond, reset and perform the ping process again. If the MGLI still fails to
respond, typical problems are shorted BNC to inter-frame cabling, open cables, crossed A and B link
cables, missing 50–Ohm terminators, or the MGLI itself.
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Figure 3-6: –48 V SC 4812T Starter Frame I/O Plate
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Basic LMF Operation

The CDMA LMF allows the user to work in the two following operating
environments, which are accessed using the specified desktop icon:

� Graphical User Interface (GUI) using the WinLMF icon

� Command Line Interface (CLI) using the WinLMF CLI icon

The GUI is the primary optimization and acceptance testing operating
environment. The CLI environment provides additional capability to the
user to perform manually controlled acceptance tests and audit the
results of optimization and calibration actions.

Basic operation of the LMF GUI  includes the following:

� Selecting and deselecting BTS devices

� Enabling devices

� Disabling devices

� Resetting devices

� Obtaining device status

� Sorting a status report window

For detailed information on performing these and other LMF operations,
refer to the CDMA LMF Operator’s Guide, 68P64114A78.

Graphical User Interface
Overview

The LMF uses a GUI, which works in the following way:

� Select the device or devices.

� Select the action to apply to the selected device(s).

� While action is in progress, a status report window displays the action
taking place and other status information.

� The status report window indicates when the the action is complete
and displays other pertinent information.

� Clicking the OK button closes the status report window.
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Command Line Interface
Overview

The LMF also provides Command Line Interface (CLI) capability.
Activate the CLI by clicking on a shortcut icon on the desktop. The CLI
can not be launched from the GUI, only from the desktop icon.

Both the GUI and the CLI use a program known as the handler. Only one
handler can be running at one time Due to architectural limitations, the
GUI must be started before the CLI if you want the GUI and CLI to use
the same handler. When the CLI is launched after the GUI, the CLI
automatically finds and uses an in–progress login session with a BTS
initiated under the GUI. This allows the use of the GUI and the CLI in
the same BTS login session. If a CLI handler is already running when
the GUI is launched (this happens if the CLI window is already running
when the user starts the GUI, or if another copy of the GUI is already
running when the user starts the GUI), a dialog window displays the
following warning message:

The CLI handler is already running.
This may cause conflicts with the LMF.
Are you sure that you want to start the application?

This window also contains yes and no buttons. Selecting yes starts the
application. Selecting no terminates the application.

CLI Format Conventions

The CLI command can be broken down in the following way:

� verb

� device including device identifier parameters

� switch

� option parameters consisting of:

– keywords

– equals signs (=) between the keywords and the parameter values

– parameter values

Spaces are required between the verb, device, switch, and option
parameters. A hyphen is required between the device and its identifiers.
Following is an example of a CLI command.

measure bbx–<bts_id>–<bbx_id> rssi channel=6 sector=5

Refer to LMF CLI Commands, R15.x 68P09251A59 for a complete
explanation of the CLI commands and their use.
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Logging into a BTS

Be sure that the correct bts–#.cdf and cbsc–#.cdf file is
used for the BTS. These should be the CDF files that are
provided for the BTS by the CBSC. Failure to use the
correct CDF files can result in invalid optimization.
Failure to use the correct CDF files to log into a live
(traffic carrying) site can shut down the site.

IMPORTANT

*

Logging into a BTS establishes a communications link between the BTS
and the CDMA LMF. You may be logged into more than one BTS at a
time, but only one LMF may be logged into each BTS.

Before attempting to log into the BTS, confirm the CDMA LMF is
properly connected to the BTS (see Figure 3-2).

Prerequisites

Before attempting to login to a BTS, ensure the following have been
completed:

� The LMF operating system is correctly installed and prepared.

� A bts-nnn folder with the correct CDF and CBSC file exists.

� The LMF is correctly installed and prepared, and the LMF computer is
connected to the BTS before starting the Windows operating system
and LMF software. If necessary, restart the computer after connecting
it to the BTS (see Table 3-2 and Figure 3-2).

BTS Login from the GUI Environment

Follow the procedure in Table 3-7 to log into a BTS when using the GUI
environment.

Table 3-7: BTS GUI Login Procedure

Step Action

1 Start the CDMA LMF GUI environment by clicking on the WinLMF desktop icon (if the LMF is not
running).

NOTE
If a warning similar to the following is displayed, select No, shut down other LMF sessions which
may be running, and start the CDMA LMF GUI environment again:

The CLI handler is already running.

This may cause conflicts with the LMF

Are you sure you want to start the application?

Yes No

2 Click on the Login tab (if not displayed).

. . . continued on next page
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Table 3-7: BTS GUI Login Procedure

Step Action

3 If no base stations are displayed in the Available Base Stations pick list, double click on the CDMA
icon.

4 Click on the desired BTS number.

5 Click on the Network Login tab (if not already in the forefront).

6 Enter the correct IP address (normally 128.0.0.2 for a field BTS) if not correctly displayed in the IP
Address box.

NOTE
128.0.0.2 is the default IP address for MGLI–1 in field BTS units. 128.0.0.1 is the default IP address
for MGLI–2.

7 Type in the correct IP Port number (normally 9216) if not correctly displayed in the IP Port box.

8 Change the Multi-Channel Preselector (from the Multi-Channel Preselector pick list), normally
MPC, corresponding to your BTS configuration, if required.

NOTE
When performing RX tests on expansion frames, do not choose EMPC if the test equipment is
connected to the starter frame.

9 Click on the Use a Tower Top Amplifier, if applicable.

10 Click on Login.

A BTS tab with the BTS is displayed.

NOTE
� If you attempt to login to a BTS that is already logged on, all devices will be gray.

� There may be instances where the BTS initiates a log out due to a system error (i.e., a device
failure).

� If the MGLI is OOS_ROM (blue), it will have to be downloaded with code before other devices can
be seen.

� If the MGLI is OOS–RAM (yellow), it must be enabled before other installed devices can be seen.
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BTS Login from the CLI Environment

Follow the procedure in Table 3-8 to log into a BTS when using the CLI
environment.

The GUI and CLI environments use the same connection to
a BTS. If a GUI and the CLI session are running for the
same BTS at the same time, logging out of the BTS in
either environment will log out of it for both. When either
a login or logout is performed in the CLI window, there is
no GUI indication that logout has occurred.

IMPORTANT

*

Table 3-8: BTS CLI Login Procedure

Step Action

1 Double click the WinLMF CLI desktop icon (if the LMF CLI environment is not already running).

NOTE
If a BTS was logged into under a GUI session when the CLI environment was started, the CLI session
will be logged into the same BTS, and step 2 is not required.

2 At the /wlmf prompt, enter the following command:

login bts–<bts#> host=<host> port=<port>
where:

host = MGLI card IP address (defaults to address last logged into for this BTS or 128.0.0.2 if this is
first login to this BTS).

port = IP port of the BTS (defaults to port last logged into for this BTS or 9216 if this is first login to
this BTS).

Logging Out

Logging out of a BTS is accomplished differently for the GUI and the
CLI operating environments.

The GUI and CLI environments use the same connection to
a BTS. If a GUI and the CLI session are running for the
same BTS at the same time, logging out of the BTS in
either environment will log out of it for both. When either
a login or logout is performed in the CLI window, there is
no GUI indication that logout has occurred.

IMPORTANT

*

Logging Out of a BTS from the GUI Environment

Follow the procedure in Table 3-9 to logout of a BTS when using the
GUI environment.

 . . . continued on next page
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Table 3-9: BTS GUI Logout Procedure

Step Action

1 Click on Select on the BTS tab menu bar.

2 Click the Logout item in the pull–down menu (a Confirm Logout pop–up message appears).

3 Click on Yes or press the <Enter> key to confirm logout.

You are returned to the Login tab.

NOTE
If a logout was previously performed on the BTS from a CLI window running at the same time as the
GUI, a Logout Error pop–up message appears stating the system should not log out of the BTS.
When this occurs, the GUI must be exited and restarted before it can be used for further operations.

4 If a Logout Error pop–up message appears stating that the system could not log out of the Base
Station because the given BTS is not logged in, perform the following actions:

– Click OK.

– Select File>Exit in the window menu bar.

– Click Yes in the Confirm Logout pop–up.

– Click Yes in the Logout Error pop–up which appears again.

5 If further work is to be done in the GUI, restart it.
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Logging Out of a BTS from the CLI Environment

Follow the procedure in Table 3-9 to logout of a BTS when using the
CLI environment.

Table 3-10: BTS CLI Logout Procedure

Step Action

* IMPORTANT
If the BTS is also logged into from a GUI running at the same time and further work must be done
with it in the GUI, proceed to step 2.

1 Logout of a BTS by entering the following command:

logout bts–<bts#>
A response similar to the following is displayed:

LMF>

12:22:58.028 Command Received and Accepted
            Command=logout bts–33

12:22:58.028 Command Received and Accepted

12:22:58.028 Command Successfully Completed
            REASON_CODE=”No Reason”

2 If desired, close the CLI interface by entering the following command:

exit
A response similar to the following is displayed before the window closes:

Killing background processes....
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Establishing an MMI
Communication Session

For those procedures that require MMI communications between the
LMF and BTS FRUs, follow the procedure in Table 3-11 to initiate the
communication session.

Table 3-11: Establishing MMI Communications

Step Action

1 Connect the LMF computer to the equipment as detailed in the applicable procedure that requires the
MMI communication session.

2 Start the named HyperTerminal connection for MMI sessions by double clicking on its desktop
shortcut.

NOTE
If a desktop shortcut was not created for the MMI connection, access the connection from the Start
menu by selecting:

Programs>Accessories>Hyperterminal>HyperTerminal><Named HyperTerminal Connection
(e.g., MMI Session).

3 Once the connection window opens, establish MMI communication with the BTS FRU by pressing
the LMF computer <Enter> key until the prompt identified in the applicable procedure is obtained.
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Figure 3-7: CDMA LMF Computer Common MMI Connections
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Download the BTS – Overview

Before a BTS can operate, each equipped device must contain device
initialization (ROM) code. ROM code is loaded in all devices during
manufacture or factory repair. Device application (RAM) code and data
must be downloaded to each equipped device by the user before the BTS
can be made fully functional for the site where it is installed.

ROM Code

Downloading ROM code to BTS devices from the LMF is NOT routine
maintenance nor a normal part of the optimization process. It is only
done in unusual situations where the resident ROM code in the device
does not match the release level of the site operating software AND the
CBSC cannot communicate with the BTS to perform the download. If
you must download ROM code, refer to Appendix H.

Before ROM code can be downloaded from the LMF, the correct ROM
code file for each device to be loaded must exist on the LMF computer.
ROM code must be manually selected for download.

RAM Code

Before RAM code can be downloaded from the CDMA LMF, the correct
RAM code file for each device must exist on the LMF computer. RAM
code can be automatically or manually selected depending on the Device
menu item chosen and where the RAM code file for the device is stored
in the CDMA LMF file structure. The RAM code file is selected
automatically if the file is in the \lmf\cdma\loads\n.n.n.n\code folder
(where n.n.n.n is the version number of the download code). The RAM
code file in the code folder must have the correct hardware bin number.

RAM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded changes to OOS-ROM
(blue). When the download is completed successfully, the device
changes to OOS-RAM (yellow). When code is downloaded to an MGLI,
the LMF automatically also downloads data, and then enables the MGLI.
When enabled, the MGLI changes to INS (green).

For non–MGLI devices, data must be downloaded after RAM code is
downloaded. To download data, the device state must be OOS–RAM
(yellow).
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Download Code to Devices

Code can be downloaded to a device that is in any state. After the
download starts, the device being downloaded changes to
OOS_ROM (blue). If the download is completed successfully, the device
changes to OOS_RAM with code loaded (yellow). Prior to downloading
a device, a code file must exist. The code file is selected automatically if
the code file is in the /lmf/cdma/n.n.n.n/code folder (where n.n.n.n is the
version number of the download code that matches the “NextLoad”
parameter in the CDF file). The code file in the code folder must have
the correct hardware bin number. Code can be automatically or manually
selected.

The following are the devices to be downloaded:

� Span Configuration

– Master Group Line Interface (MGLI2)

– Slave Group Line Interface (SGLI2)

� Clock Synchronization Module (CSM)

� Multi Channel Card (MCC24E, MCC8E or MCC–1X)

� Broadband Transceiver (BBX)

� Test Subscriber Interface Card (TSIC) – if RFDS is installed

The MGLI must be successfully downloaded with code and
data, and put INS before downloading any other device.
The download code process for an MGLI automatically
downloads data and enables the MGLI before downloading
other devices. The other devices can be downloaded in any
order.

IMPORTANT

*

Follow the procedure in Table 3-12 to download the firmware
application code for the MGLI2. The download code action downloads
data and also enables the MGLI2.

Prerequisite

Prior to performing this procedure, ensure a code file exists for each of
the devices to be downloaded.

 . . . continued on next page
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R9 RAM code must NOT be downloaded to a device that
has R8 ROM code and R8 RAM code must NOT be
downloaded to a device that has R9 ROM code. All
devices in a BTS must have the same R–level ROM and
RAM code before the optimization and ATP procedures
can be performed. If a newly installed R8 BTS is to be
upgraded to R9, the optimization and ATPs should be
accomplished with the R8 code. Then the site should be
upgraded to R9 by the CBSC. The optimization and ATP
procedures do not have to be performed again after the R9
upgrade. If a replacement R8 device needs to be used in a
R9 BTS, the device ROM code can be changed with use of
the LMF before the optimization and ATPs are performed
for the BTS. Refer to the Download ROM Code section. A
R9 device can not be converted back to a R8 device in the
field without Motorola assistance.

WARNING

Table 3-12: Download and Enable MGLI2

� Step Action

1 Select Util>Tools>Update Next Load function to ensure the Next Load parameter is set to the
correct code version level.

2 Download code to the primary MGLI2 by clicking on the MGLI2.

– From the Device pull down menu, select Download Code.
A status report confirms change in the device(s) status.

– Click OK to close the status window. (The MGLI2 should automatically be downloaded with
data and enabled.)

3 Download code and data to the redundant MGLI2 but do not enable at this time.
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Download Code and Data to
Non–MGLI2 Devices

Non–MGLI2 devices can be downloaded individually or all equipped
devices can be downloaded with one action. Follow the procedure in
Table 3-13 to download code and data to the non–MGLI2 devices.

When downloading multiple devices, the download may
fail for some of the devices (a time out occurs). These
devices can be downloaded separately after completing the
multiple download.

NOTE

Table 3-13: Download Code and Data to Non–MGLI Devices

� Step Action

1 Select all devices to be downloaded.

2 From the Device pull down menu, select Download Code.

A status report displays the result of the download for each selected device.

Click OK to close the status window.

NOTE
After the download has started, the device being downloaded changes to blue. If the download is
completed successfully, the device changes to yellow (OOS-RAM with code loaded).

After a BBX, CSM or MCC is successfully downloaded with code and has changed to
OOS-RAM, the status LED should be rapidly flashing GREEN.

3 To download the firmware application data to each device, select the target device and select:
Device>Download Data

Select CSM Clock Source

A CSM can have three different clock sources. The Clock Source
function can be used to select the clock source for each of the three
inputs. This function is only used if the clock source for a CSM needs to
be changed. The Clock Source function provides the following clock
source options:

� Local GPS

� Remote GPS

� HSO (only for sources 2 & 3)

� LFR (only for sources 2 & 3)

� 10 MHz (only for sources 2 & 3)

� NONE (only for sources 2 & 3)

Prerequisites

MGLI=INS_ACT

CSM= OOS_RAM or INS_ACT
 . . . continued on next page
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Follow the procedure in Table 3-14 to select a CSM Clock Source.

Table 3-14: Select CSM Clock Source

Step Action

1 Select the applicable CSM(s).

2 Click on the Device menu.

3 Click on the Clock Source menu item.

4 Click on the Select menu item.

A clock source selection window is displayed.

5 Select the applicable clock source in the Clock Reference Source pick lists.

Uncheck the related check box if you do not want the displayed pick list item to be used.

6 Click on the OK button.

A status report window displays the results of the selection action.

7 Click on the OK button to close the status report window.
 

Enable CSMs

Each BTS CSM system features two CSM boards per site. In a typical
operation, the primary CSM locks its Digital Phase Locked Loop
(DPLL) circuits to GPS signals. These signals are generated by either an
on–board GPS module (RF–GPS) or a remote GPS receiver (R–GPS).
The CSM2 card is required when using the R–GPS. The GPS receiver
(mounted on CSM–1) is the primary timing reference and synchronizes
the entire cellular system. CSM–2 provides redundancy but does not
have a GPS receiver.

The BTS may be equipped with a remote GPS, LORAN–C LFR, or
HSO 10 MHz Rubidium source, which the CSM can use as a secondary
timing reference. In all cases, the CSM monitors and determines what
reference to use at a given time.

– CSMs are code loaded at the factory. This data is
retained in EEPROM. The download code procedure
is required in the event it becomes necessary to code
load CSMs with updated software versions. Use the
status function to determine the current code load
versions.

– For non–RGPS sites only, verify the CSM configured
with the GPS receiver “daughter board” is installed in
the CSM–1 slot before continuing.

– The CSM(s) and MCC(s) to be enabled must have
been downloaded with code (Yellow, OOS–RAM)
and data.

IMPORTANT

*

 . . . continued on next page
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Follow the procedure in Table 3-15 to enable the CSMs.

Table 3-15: Enable CSMs

� Step Action

1 Verify the CSM(s) have been downloaded with code (Yellow, OOS–RAM) and data.

2 Click on the target CSM.

From the Device pull down, select Enable.

NOTE
If equipped with two CSMs, enable CSM–2 first and then CSM–1.

A status report confirms change in the device(s) status.

Click OK to close the status window.

NOTE
FAIL may be shown in the status table for enable action. If Waiting For Phase Lock is shown in
the Description field, the CSM changes to the enabled state after phase lock is achieved. CSM–1
houses the GPS receiver. The enable sequence can take up to one hour to complete.

* IMPORTANT
The GPS satellite system satellites are not in a geosynchronous orbit and are maintained and
operated by the United States Department of Defense (D.O.D.). The D.O.D. periodically alters
satellite orbits; therefore, satellite trajectories are subject to change. A GPS receiver that is INS
contains an “almanac” that is updated periodically to take these changes into account.

If an installed GPS receiver has not been updated for a number of weeks, it may take up to one
hour for the GPS receiver “almanac” to be updated.

Once updated, the GPS receiver must track at least four satellites and obtain (hold) a 3-D position
fix for a minimum of 45 seconds before the CSM will come in-service. (In some cases, the GPS
receiver needs to track only one satellite, depending on accuracy mode set during the data load.)

3 NOTE
If equipped with two CSMs, the LMF should display CSM-1 as bright GREEN (INS–ACT) and
CSM–2 as dark green (INS–STB). After the CSMs have been successfully enabled, the
PWR/ALM LEDs are steady green (alternating green/red indicates the card is in an alarm state).

If more than an hour has passed, refer to Table 3-19 and Table 3-20 to determine the cause.
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Enable MCCs

This procedure configures the MCC and sets the “tx fine adjust”
parameter. The “tx fine adjust” parameter is not a transmit gain setting,
but a timing adjustment that compensates for the processing delay in the
BTS (approximately 3 �s).

Follow the procedure in Table 3-16 to enable the MCCs.

The MGLI2, and primary CSM must be downloaded and
enabled (IN–SERVICE ACTIVE), before downloading and
enabling the MCC.

IMPORTANT

*

Table 3-16: Enable MCCs

� Step Action

1 Verify the MCC(s) have been downloaded with code (Yellow, OOS–RAM) and data.

2 Select the MCCs to be enabled or from the Select pulldown menu choose All MCCs.

3 From the Device menu, select Enable

A status report confirms change in the device(s) status.

4 Click on OK to close the status report window.

Enable Redundant GLIs

Follow the procedure in Table 3-17 to enable the redundant GLI(s).

Table 3-17: Enable Redundant GLIs

� Step Action

1 Select the target redundant GLI(s).

2 From the Device menu, select Enable.

A status report window confirms the change in the device(s) status and the enabled GLI(s) is
green.

3 Click on OK to close the status report window.
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CSM & LFR Background

The primary function of the Clock Synchronization Manager (CSM)
boards (slots 1 and 2) is to maintain CDMA system time. The CSM in
slot 1 is the primary timing source while slot 2 provides redundancy. The
CSM2 card (CSM second generation) is required when using the remote
GPS receiver (R–GPS). R–GPS uses a GPS receiver in the antenna head
that has a digital output to the CSM2 card. CSM2 can have a daughter
card as a local GPS receiver to support an RF–GPS signal.

The CSM2 switches between the primary and redundant units (slots 1
and 2) upon failure or command. CDMA Clock Distribution
Cards (CCDs) buffer and distribute even–second reference and 19.6608
MHz clocks. CCD–1 is married to CSM–1 and CCD–2 is married to
CSM 2. A failure on CSM–1 or CCD–1 cause the system to switch to
redundant CSM–2 and CCD–2.

In a typical operation, the primary CSM locks its Digital Phase Locked
Loop (DPLL) circuits to GPS signals. These signals are generated by
either an on–board GPS module (RF–GPS) or a remote GPS receiver
(R–GPS). The CSM2 card is required when using the R–GPS. DPLL
circuits employed by the CSM provide switching between the primary
and redundant unit upon request. Synchronization between the primary
and redundant CSM cards, as well as the LFR or HSO back–up source,
provides excellent reliability and performance.

Each CSM board features an ovenized, crystal oscillator that provides
19.6608 MHz clock, even second tick reference, and 3 MHz sinewave
reference, referenced to the selected synchronization source (GPS,
LORAN–C Frequency Receiver (LFR), or High Stability Oscillator
(HSO), T1 Span, or external reference oscillator sources). The 3 MHz
signals are also routed to the RDM EXP 1A & 1B connectors on the top
interconnect panel for distribution to co–located frames at the site.

Fault management has the capability of switching between the GPS
synchronization source and the LFR/HSO backup source in the event of
a GPS receiver failure on CSM–1. During normal operation, the CSM–1
board selects GPS as the primary source (see Table 3-19). The source
selection can also be overridden via the LMF or by the system software.

All boards are mounted in the C–CCP shelf at the top of the BTS frame.
Figure 3-9 on page 3-36 illustrates the location of the boards in the BTS
frame. The diagram also shows the CSM front panel.
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Low Frequency Receiver/
High Stability Oscillator

The CSM handles the overall configuration and status monitoring
functions of the LFR/HSO. In the event of GPS failure, the LFR/HSO is
capable of maintaining synchronization initially established by the GPS
reference signal.

The LFR requires an active external antenna to receive LORAN RF
signals. Timing pulses are derived from this signal, which is
synchronized to Universal Time Coordinates (UTC) and GPS time. The
LFR can maintain system time indefinitely after initial GPS lock.

The HSO is a high stability 10 MHz oscillator with the necessary
interface to the CSMs. The HSO is typically installed in those
geographical areas not covered by the LORAN–C system. Since the
HSO is a free–standing oscillator, system time can only be maintained
for 24 hours after 24 hours of GPS lock.

Upgrades and Expansions: LFR2/HSO2/HSOX

LFR2/HSO2 (second generation cards) both export a timing signal to the
expansion or logical BTS frames. The associated expansion or logical
frames require an HSO–expansion (HSOX) whether the starter frame has
an LFR2 or an HSO2. The HSOX accepts input from the starter frame
and interfaces with the CSM cards in the expansion frame. LFR and
LFR2 use the same source code in source selection (see Table 3-18).
HSO, HSO2, and HSOX use the same source code in source selection
(see Table 3-18).

Allow the base site and test equipment to warm up for
60 minutes after any interruption in oscillator power. CSM
board warm-up allows the oscillator oven temperature and
oscillator frequency to stabilize prior to test. Test
equipment warm-up allows the Rubidium standard
timebase to stabilize in frequency before any measurements
are made.

NOTE

Front Panel LEDs

The status of the LEDs on the CSM boards are as follows:

� Steady Green – Master CSM locked to GPS or LFR (INS).

� Rapidly Flashing Green – Standby CSM locked to GPS or LFR
(STBY).

� Flashing Green/Rapidly Flashing Red – CSM OOS–RAM attempting
to lock on GPS signal.

� Rapidly Flashing Green and Red – Alarm condition exists. Trouble
Notifications (TNs) are currently being reported to the GLI.
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Null Modem Cable
A null modem cable is required. It is connected between the LMF
COM1 port and the RS232–GPIB Interface box. Figure 3-8 shows the
wiring detail for the null modem cable.

Figure 3-8: Null Modem Cable Detail
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Prerequisites

Ensure the following prerequisites have been met before proceeding:

� The LMF is NOT logged into the BTS.

� The COM1 port is connected to the MMI port of the primary CSM via
a null modem board.

CSM Frequency Verification

The objective of this procedure is the initial verification of the CSM
boards before performing the rf path verification tests. Parts of this
procedure will be repeated for final verification after the overall
optimization has been completed.

Test Equipment Setup: GPS &
LFR/HSO Verification

Follow the procedure in Table 3-18 to set up test equipment while
referring to Figure 3-9 as required.

Table 3-18: Test Equipment Setup (GPS & LFR/HSO Verification)

Step Action

1 Perform one of the following operations:

– For local GPS (RF–GPS), verify a CSM board with a GPS receiver is installed in primary CSM
slot 1 and that CSM–1 is INS.

NOTE
This is verified by checking the board ejectors for kit number SGLN1145 on the board in slot 1.

– For Remote GPS (RGPS), verify a CSM2 board is installed in primary slot 1 and that CSM–1 is
INS

NOTE
This is verified by checking the board ejectors for kit number SGLN4132CC (or subsequent).

2 Remove CSM–2 (if installed) and connect a serial cable from the LMF COM 1 port (via null modem
board) to the MMI port on CSM–1.

. . . continued on next page
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Table 3-18: Test Equipment Setup (GPS & LFR/HSO Verification)

Step Action

3 Reinstall CSM–2.

4 Start an MMI communication session with CSM–1 by using the Windows desktop shortcut icon (see
Table 3-5)

NOTE
The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

5 When the terminal screen appears, press the <Enter> key until the CSM> prompt appears.

 

Figure 3-9: CSM MMI terminal connection
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GPS Initialization/Verification

Follow the procedure in Table 3-19 to initialize and verify proper GPS
receiver operation.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� The LMF is not logged into the BTS.

� The COM1 port is connected to the MMI port of the primary CSM via
a null modem board (see Figure 3-9).

� The primary CSM and HSO (if equipped) have been warmed up for at
least 15 minutes.

� Connect the GPS antenna to the GPS RF connector
ONLY. Damage to the GPS antenna and/or receiver
can result if the GPS antenna is inadvertently connected
to any other RF connector.

CAUTION

Table 3-19: GPS Initialization/Verification

Step Action

1 To verify that Clock alarms (0000), Dpll is locked and has a reference source, and
GPS self test passed messages are displayed within the report, issue the following MMI
command

bstatus

– Observe the following typical response:

CSM Status INS:ACTIVE Slot A Clock MASTER.

BDC_MAP:000, This CSM’s BDC Map:0000

Clock Alarms (0000):

DPLL is locked and has a reference source.
GPS receiver self test result: passed

Time since reset 0:33:11, time since power on: 0:33:11

2 HSO information (underlined text above, verified from left to right) is usually the #1 reference source.
If this is not the case, have the OMCR determine the correct BTS timing source has been identified in
the database by entering the display bts csmgen command and correct as required using the edit
csm csmgen refsrc command.

* IMPORTANT
If any of the above mentioned areas fail, verify:

– If LED is RED, verify that HSO had been powered up for at least 5 minutes. After oscillator
temperature is stable, LED should go GREEN Wait for this to occur before continuing !

– If “timed out” is displayed in the Last Phase column, suspect the HSO output buffer or oscillator
is defective

– Verify the HSO is FULLY SEATED and LOCKED to prevent any possible board warpage

. . . continued on next page
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Table 3-19: GPS Initialization/Verification

Step Action

3 Verify the following GPS information (underlined text above):

– GPS information is usually the 0 reference source.

– At least one Primary source must indicate “Status = good” and “Valid = yes” to bring site up.

4 Enter the following command at the CSM> prompt to verify that the GPS receiver is in tracking mode.

gstatus

– Observe the following typical response:

24:06:08 GPS Receiver Control Task State: tracking satellites.
24:06:08 Time since last valid fix: 0 seconds.
24:06:08 
24:06:08 Recent Change Data:
24:06:08 Antenna cable delay 0 ns.
24:06:08 Initial position: lat 117650000 msec, lon –350258000 msec, height 0 cm (GPS)
24:06:08 Initial position accuracy (0): estimated.
24:06:08 
24:06:08 GPS Receiver Status:
24:06:08 Position hold:  lat 118245548 msec, lon –350249750 msec, height 20270 cm
24:06:08 Current position: lat 118245548 msec, lon –350249750 msec, height 20270 cm
(GPS)
24:06:08 8 satellites tracked, receiving 8 satellites, 8 satellites visible.
24:06:08 Current Dilution of Precision (PDOP or HDOP): 0.
24:06:08 Date & Time: 1998:01:13:21:36:11
24:06:08 GPS Receiver Status Byte: 0x08
24:06:08 Chan:0, SVID: 16, Mode: 8, RSSI: 148, Status: 0xa8
24:06:08 Chan:1, SVID: 29, Mode: 8, RSSI: 132, Status: 0xa8
24:06:08 Chan:2, SVID: 18, Mode: 8, RSSI: 121, Status: 0xa8
24:06:08 Chan:3, SVID: 14, Mode: 8, RSSI: 110, Status: 0xa8
24:06:08 Chan:4, SVID: 25, Mode: 8, RSSI:  83, Status: 0xa8
24:06:08 Chan:5, SVID:  3, Mode: 8, RSSI:  49, Status: 0xa8
24:06:08 Chan:6, SVID: 19, Mode: 8, RSSI: 115, Status: 0xa8
24:06:08 Chan:7, SVID: 22, Mode: 8, RSSI: 122, Status: 0xa8
24:06:08 
24:06:08 GPS Receiver Identification:
24:06:08 COPYRIGHT 1991–1996 MOTOROLA INC. 
24:06:08 SFTW P/N # 98–P36830P      
24:06:08 SOFTWARE VER # 8           
24:06:08 SOFTWARE REV # 8           
24:06:08 SOFTWARE DATE  6 AUG 1996 
24:06:08 MODEL #    B3121P1115      
24:06:08 HDWR P/N # _               
24:06:08 SERIAL #   SSG0217769      
24:06:08 MANUFACTUR DATE 6B07       
24:06:08 OPTIONS LIST    IB        
24:06:08 The receiver has 8 channels and is equipped with TRAIM.

5 Verify the following GPS information (shown above in underlined text):

– At least 4 satellites are tracked, and 4 satellites are visible.

– GPS Receiver Control Task State is “tracking satellites”. Do not continue until this occurs!

– Dilution of Precision indication is not more that 30.

Record the current position base site latitude, longitude, height and height reference (height reference
to Mean Sea Level (MSL) or GPS height (GPS).  (GPS = 0   MSL = 1).

. . . continued on next page
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Table 3-19: GPS Initialization/Verification

Step Action

6 If steps 1 through 5 pass, the GPS is good.

* IMPORTANT
If any of the above mentioned areas fail, verify that:

– If Initial position accuracy is “estimated” (typical), at least 4 satellites must be tracked and
visible (1 satellite must be  tracked and visible if actual lat, log, and height data for this site has
been entered into CDF file).

– If Initial position accuracy is “surveyed”, position data currently in the CDF file is assumed to be
accurate. GPS will not automatically survey and update its position.

– The GPS antenna is not obstructed or misaligned.

– GPS antenna connector center conductor measures approximately +5 Vdc with respect to the
shield.

– There is no more than 4.5 dB of loss between the GPS antenna OSX connector and the BTS frame
GPS input.

– Any lightning protection installed between GPS antenna and BTS frame is installed correctly.

7 Enter the following commands at the CSM> prompt to verify that the CSM is warmed up and that GPS
acquisition has taken place.

debug dpllp 

Observe the following typical response if the CSM is not warmed up (15 minutes from application of
power)  (If warmed–up proceed to step 8)

CSM>DPLL Task Wait. 884 seconds left.
DPLL Task Wait. 882 seconds left.
DPLL Task Wait. 880 seconds left.   ...........etc.

NOTE
The warm command can be issued at the MMI port used to force the CSM into warm–up, but the
reference oscillator will be unstable.

8 Observe the following typical response if the CSM is warmed up.

c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175
c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175

9 Verify the following GPS information (underlined text above, from left to right):

– Lower limit offset from tracked source variable is not less than –60 (equates to 3µs limit).

– Upper limit offset from tracked source variable is not more than +60 (equates to 3µs limit).

– TK SRC: 0 is selected, where SRC 0 = GPS.

10 Enter the following commands at the CSM> prompt to exit the debug mode display.

debug  dpllp
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LFR Initialization/Verification
The LORAN–C LFR is a full size card that resides in the C–CCP Shelf.
The LFR is a completely self-contained unit that interfaces with the
CSM via a serial communications link. The CSM handles the overall
configuration and status monitoring functions of the LFR.

The LFR receives a 100 kHz, 35 kHz BW signal from up to 40 stations
(8 chains) simultaneously and provides the following major functions:

� Automatic antenna pre-amplifier calibration (using a second
differential pair between LFR and LFR antenna)

� A 1 second ±200 ηs strobe to the CSM

If the BTS is equipped with an LFR, follow the procedure in Table 3-20
to initialize the LFR and verify proper operation as a backup source for
the GPS.

If CSMRefSrc2 = 2 in the CDF file, the BTS is equipped
with an LFR. If CSMRefSrc2 = 18, the BTS is equipped
with an HSO.

NOTE

 . . . continued on next page
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Table 3-20: LFR Initialization/Verification

Step Action Note

1 At the CSM> prompt, enter lstatus <cr> to verify that the LFR is in tracking
mode. A typical response is:

CSM> lstatus <cr>
LFR St ti St tLFR Station Status:
Clock coherence: 512 >
5930M 51/60 dB 0 S/N Flag:
5930X 52/64 dn –1 S/N Flag:
5990 47/55 dB –6 S/N Flag:
7980M 62/66 dB 10 S/N Fl

This must be greater
than 100 before LFR
becomes a valid source.

7980M 62/66 dB 10 S/N Flag:
7980W 65/69 dB 14 S/N Flag: . PLL Station . >
7980X 48/54 dB –4 S/N Flag:
7980Y 46/58 dB –8 S/N Flag:E
7980Z 60/67 dB 8 S/N Flag:
8290M 50/65 dB 0 S/N Flag

This shows the LFR is
locked to the selected
PLL station.

8290M 50/65 dB 0 S/N Flag:
8290W 73/79 dB 20 S/N Flag:
8290W 58/61 dB 6 S/N Flag:8290W 58/61 dB 6 S/N Flag:
8970M 89/95 dB 29 S/N Flag:
8970W 62/66 dB 10 S/N Flag:
8970X 73/79 dB 22 S/N Flag:8970X 73/79 dB 22 S/N Flag:
8970Y 73/79 dB 19 S/N Flag:
8970Z 62/65 dB 10 S/N Flag:
9610M 62/65 dB 10 S/N Fl

g
9610M 62/65 dB 10 S/N Flag:
9610V 58/61 dB 8 S/N Flag:
9610W 47/49 dB –4 S/N Flag:E9610W 47/49 dB –4 S/N Flag:E
9610X 46/57 dB –5 S/N Flag:E
9610Y 48/54 dB –5 S/N Flag:E
9610Z 65/69 dB 12 S/N Flag9610Z 65/69 dB 12 S/N Flag:
9940M 50/53 dB –1 S/N Flag:S
9940W 49/56 dB –4 S/N Flag:E9940W 49/56 dB 4 S/N Flag:E
9940Y 46/50 dB–10 S/N Flag:E
9960M 73/79 dB 22 S/N Flag:
9960W 51/60 dB 0 S/N Flag:9960W 51/60 dB 0 S/N Flag:
9960X 51/63 dB –1 S/N Flag:
9960Y 59/67 dB 8 S/N Flag:
9960Z 89/96 dB 29 S/N Fl9960Z 89/96 dB 29 S/N Flag:

LFR Task State: lfr locked to station 7980W
LFR Recent Change Data:

Search List: 5930 5990 7980 8290 8970 9940 9610 9960 >
PLL GRI: 7980W

LFR Master, reset not needed, not the reference source.
CSM>

This search list and PLL
data must match the
configuration for the
geographical location
of the cell site.

. . . continued on next page
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Table 3-20: LFR Initialization/Verification

Step NoteAction

2 Verify the following LFR information (highlighted above in boldface type):

– Locate the “dot” that indicates the current phase locked station assignment (assigned by MM).

– Verify that the station call letters are as specified in site documentation as well as M X Y Z
assignment.

– Verify the signal to noise (S/N) ratio of the phase locked station is greater than 8.

3 At the CSM> prompt, enter sources <cr> to display the current status of the the LORAN receiver.

– Observe the following typical response.

Num Source Name Type TO Good Status Last Phase Target Phase Valid
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 Local GPS Primary 4 Yes Good –3 0 Yes
1 LFR ch A Secondary 4 Yes Good –2013177 –2013177 Yes
2 Not used
Current reference source number: 1

4 LORAN–C LFR information (highlighted above in boldface type) is usually the #1 reference source
(verified from left to right).

* IMPORTANT
If any of the above mentioned areas fail, verify:

– The LFR antenna is not obstructed or misaligned.

– The antenna pre–amplifier power and calibration twisted pair connections are intact and < 91.4 m
(300 ft) in length.

– A dependable connection to suitable Earth Ground is in place.

– The search list and PLL station for cellsite location are correctly configured .

NOTE
LFR functionality should be verified using the “source” command (as shown in Step 3). Use the
underlined responses on the LFR row to validate correct LFR operation.

5 Close the Hyperterminal window.
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HSO Initialization/Verification

The HSO module is a full–size card that resides in the C–CCP Shelf.
This completely self contained high stability 10 MHz oscillator
interfaces with the CSM via a serial communications link. The CSM
handles the overall configuration and status monitoring functions of the
HSO. In the event of GPS failure, the HSO is capable of maintaining
synchronization initially established by the GPS reference signal for a
limited time.

The HSO is typically installed in those geographical areas not covered
by the LORAN–C system and provides the following major functions:

� Reference oscillator temperature and phase lock monitor circuitry

� Generates a highly stable 10 MHz sine wave.

� Reference divider circuitry converts 10 MHz sine wave to 10 MHz
TTL signal, which is divided to provide a 1 PPS strobe to the CSM.

Prerequisites
� The LMF is not logged into the BTS.

� The COM1 port is connected to the MMI port of the primary CSM via
a null modem board.

� The primary CSM and the HSO (if equipped) have warmed up for 15
minutes.

If the BTS is equipped with an HSO, follow the procedure in Table 3-21
to configure the HSO.

Table 3-21: HSO Initialization/Verification

Step Action

1 At the BTS, slide the HSO card into the cage.

NOTE
The LED on the HSO should light red for no longer than 15-minutes, then switch to green. The CSM
must be locked to GPS.

2 On the LMF at the CSM> prompt, enter sources <cr>.

– Observe the following typical response for systems equipped with HSO:

Num Source Name Type TO Good Status Last Phase Target Phase Valid
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 Local GPS Primary 4 Yes Good 0 0 Yes
1 HSO Backup 4 Yes N/A xxxxxxx –69532 Yes
2 Not used
Current reference source number: 0

When the CSM is locked to GPS, verify that the HSO “Good” field is Yes and the “Valid” field is Yes.

3 If source “1” is not configured as HSO, enter at the CSM> prompt: ss 1 12 <cr>

Check for Good in the Status field.

4 At the CSM> prompt, enter sources <cr>.

Verify the HSO valid field is Yes. If not, repeat this step until the “Valid” status of Yes is returned. The
HSO should be valid within one (1) minute, assuming the DPLL is locked and the HSO Rubidium
oscillator is fully warmed.
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Connecting Test Equipment to
the BTS

All test equipment is controlled by the LMF via an IEEE–488/GPIB bus.
The LMF requires each piece of test equipment to have a factory set
GPIB address. If there is a communications problem between the LMF
and any piece of test equipment, verify that the GPIB addresses have
been set correctly (normally 13 for a power meter and 18 for a CDMA
analyzer).

The following equipment is required to perform optimization:

� LMF

� Test set

� Directional coupler and attenuator

� RF cables and connectors

Refer to Table 3-22 for an overview of connections for test equipment
currently supported by the LMF. In addition, see the following figures:

� Figure 3-11 and Figure 3-12 show the test set connections for TX
calibration.

� Figure 3-13 and Figure 3-14 show the test set connections for
optimization/ATP tests.

� Figure 3-15 and Figure 3-16 show typical TX and RX ATP setup with
a directional coupler (shown with and without RFDS).

Supported Test Sets
Optimization and ATP testing may be performed using one of the
following test sets:

� CyberTest

� Advantest R3465 and HP 437B or Gigatronics Power Meter

� Hewlett–Packard HP 8935

� Hewlett–Packard HP 8921 (W/CDMA and PCS Interface for
1.7/1.9 GHz) and HP 437B or Gigatronics Power Meter

� Spectrum Analyzer (HP8594E) – optional

� Rubidium Standard Timebase – optional

To prevent damage to the test equipment, all TX test
connections must be through the directional coupler and
in-line attenuator as shown in the test setup illustrations.

CAUTION
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Test Equipment Reference
Chart

Table 3-22 depicts the current test equipment available meeting Motorola
standards.

To identify the connection ports, locate the test equipment presently
being used in the TEST SETS columns, and read down the column.
Where a ball appears in the column, connect one end of the test cable to
that port. Follow the horizontal line to locate the end connection(s),
reading up the column to identify the appropriate equipment/BTS port.

Table 3-22: Test Equipment Setup
TEST SETS ADDITIONAL TEST EQUIPMENT

SIGNAL
Cyber–

Test
Ad-

vantest
HP

8935
HP

8921A

HP
8921

W/PCS
Power
Meter

GPIB
Inter-
face LMF

Directional
Coupler & Pad* BTS

EVEN SECOND 
SYNCHRONIZATION

EVEN
SEC REF

EVEN SEC
SYNC IN

EVEN
SECOND
SYNC IN

EVEN
SECOND
SYNC IN

EVEN
SECOND
SYNC IN

19.6608 MHZ
CLOCK

TIME
BASE IN

CDMA
TIME BASE

IN
EXT

REF IN

CDMA
TIME BASE

IN

CDMA
TIME BASE

IN

CONTROL
IEEE 488 BUS

IEEE
488 GPIB HP–IB HP–IB GPIB

SERIAL
PORTHP–IB HP–IB

TX TEST
CABLES

RF
IN/OUT

INPUT
50–OHM

RF
IN/OUT TX1–6

RF
IN/OUT

RF
IN/OUT

20 DB
PAD

BTS
PORT

RX TEST
CABLES

RF GEN
OUT

RF OUT
50–OHM DUPLEX RX1–6

DUPLEX
OUT

RF OUT
ONLY

SYNC
MONITOR

FREQ
MONITOR
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Equipment Warm-up

Warm-up BTS equipment for a minimum of 60 minutes
prior to performing the BTS optimization procedure. This
assures BTS site stability and contributes to optimization
accuracy. (Time spent running initial power-up,
hardware/firmware audit, and BTS download counts as
warm-up time.)

IMPORTANT

*

Calibrating Cables
Figure 3-10 shows the cable calibration setup for various supported test
sets. The left side of the diagram depicts the location of the input and
output ports of each test set, and the right side details the set up for each
test.

Before installing any test equipment directly to any BTS
TX OUT connector, verify there are NO CDMA BBX
channels keyed. At active sites, have the OMC-R/CBSC
place the antenna (sector) assigned to the LPA under test
OOS. Failure to do so can result in serious personal injury
and/or equipment damage.

WARNING

 . . . continued on next page
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Figure 3-10: Cable Calibration Test Setup

ÏÏÏÏ
ÏÏÏÏÌ

ÁÁ
ÁÁ
ÁÁ
ÁÁÁÁÁÁÁÁ
Á
Á
Á
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Motorola CyberTest

Hewlett–Packard Model HP 8935

Advantest Model R3465

DUPLEX
OUT

RF OUT
50–OHM

INPUT
50–OHM

RF GEN OUTANT IN

ANT
IN

SUPPORTED TEST SETS

100–WATT  (MIN)
NON–RADIATING

RF LOAD

TEST
SET

A. SHORT CABLE CAL

SHORT
CABLE

B. RX TEST SETUP

TEST
SET

C. TX TEST SETUP

20 DB PAD
FOR 1.9 GHZ

CALIBRATION SET UP

N–N FEMALE
ADAPTER

TX
CABLE

TX
CABLE

SHORT
CABLE

Note: The Directional Coupler is not used with the
Cybertest Test Set. The TX cable is connected
directly to the Cybertest Test Set.

A 10dB attenuator must be used with the short test
cable for cable calibration with the CyberTest Test
Set. The 10dB attenuator is used only for the cable
calibration procedure, not with the test cables for
TX calibration and ATP tests.

TEST
SET

RX
CABLE

SHORT
CABLE

FW00089

Note: For 800 MHZ only. The HP8921A cannot
be used to calibrate cables for PCS frequencies.

Hewlett–Packard Model HP 8921A

DIRECTIONAL COUPLER 
(30 DB)

N–N FEMALE
ADAPTER
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Setup for TX Calibration

Figure 3-11 and Figure 3-12 show the test set connections for TX
calibration.

ÁÁ
ÁÁ
ÁÁ
ÁÁÁÁÁÁÁÁ
Á
Á
Á
ÁÁÁÁÁ

Motorola CyberTest

Hewlett–Packard Model HP 8935

TEST SETS TRANSMIT (TX) SET UP

ÏÏÏ
ÏÏÏÌ

FRONT PANEL
RF

IN/OUT

RF IN/OUT

HP–IB
TO GPIB
BOX

RS232–GPIB
INTERFACE BOX

INTERNAL PCMCIA
ETHERNET CARD

GPIB
CABLE

COMMUNICATIONS
TEST SET

CONTROL
IEEE 488
GPIB BUS

UNIVERSAL TWISTED
PAIR (UTP) CABLE

(RJ45 CONNECTORS)

RS232
NULL
MODEM
CABLE

OUT

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS

G MODE

ON

TEST SET
INPUT/

OUTPUT
PORTS

BTS

100–WATT (MIN)
NON–RADIATING
RF LOAD

IN

TX
TEST
CABLE

CDMA
LMF

DIP SWITCH SETTINGS

2O DB PAD
(FOR 1.7/1.9 GHZ)

10BASET/
10BASE2
CONVERTER

LAN
B

LAN
A

TX TEST
CABLE

TX ANTENNA
PORT OR TX

RFDS
DIRECTIONAL

COUPLERS

POWER
METER

(OPTIONAL)*

NOTE: THE DIRECTIONAL COUPLER IS NOT USED WITH THE
CYBERTEST TEST SET. THE TX CABLE IS CONNECTED DIRECTLY
TO THE CYBERTEST TEST SET.

Advantest Model R3465

INPUT
50–OHM

GPIB
CONNECTS  TO
BACK OF UNIT

* A POWER METER CAN BE USED IN PLACE
OF THE COMMUNICATIONS TEST SET FOR TX
CALIBRATION/AUDIT

POWER
SENSOR

Figure 3-11: TX Calibration Test Setup (CyberTest, HP 8935, and Advantest)

REF FW00094

30 DB
DIRECTIONAL
COUPLER
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Figure 3-12: TX Calibration Test Setup HP 8921A W/PCS for 1.7/1.9 GHz

Hewlett–Packard Model HP 8921A W/PCS Interface

POWER METER

TEST SETS TRANSMIT (TX) SET UP

RS232–GPIB
INTERFACE BOX

INTERNAL PCMCIA
ETHERNET CARD

GPIB
CABLE

UNIVERSAL TWISTED
PAIR (UTP) CABLE

(RJ45 CONNECTORS)

RS232
NULL
MODEM
CABLE

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

BTS

30 DB
DIRECTIONAL
COUPLER
WITH UNUSED
PORT TERMINATED

100–WATT  (MIN)
NON–RADIATING
RF LOAD

TX
TEST
CABLE

CDMA
LMF

DIP SWITCH SETTINGS

2O DB PAD

10BASET/
10BASE2
CONVERTER

LAN
B

LAN
A

TX ANTENNA
GROUP OR TX

RFDS
DIRECTIONAL

COUPLERS

Note: The HP 8921A cannot be used for TX
calibration. A power meter must be used.

TX
TEST
CABLE

POWER
SENSOR

FW00095
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Setup for Optimization/ATP

Figure 3-13 and Figure 3-14 show the test set connections for
optimization/ATP tests.

ÁÁÁÁÁÁÁÁÁÁ
ÁÁ
ÁÁÁÁÁ
Á
Á
Á

Motorola CyberTest

Hewlett–Packard Model HP 8935

DUPLEX OUT

TEST SETS Optimization/ATP SET UP

ÏÏÏÏ
ÏÏÏÏ
ÏÏÏÏÌ

RF
IN/OUT

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSM BOARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSM BOARD

RF IN/OUT

HP–IB
TO GPIB
BOX

Advantest Model R3465

INPUT
50–OHM

GPIB CONNECTS
TO BACK OF UNIT

NOTE: The Directional Coupler is not used
with the Cybertest Test Set. The TX cable is
connected directly to the Cybertest Test set.

RF OUT

RX ANTENNA
PORT OR RFDS
RX ANTENNA
DIRECTIONAL

COUPLER

TX ANTENNA
PORT OR RFDS
RX ANTENNA
DIRECTIONAL

COUPLER

RS232–GPIB
INTERFACE BOX

INTERNAL PCMCIA
ETHERNET CARD

GPIB
CABLE

UNIVERSAL TWISTED
PAIR (UTP) CABLE

(RJ45 CONNECTORS)

RS232 NULL
MODEM
CABLE

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

BTS

TX
TEST
CABLE

CDMA
LMF

DIP SWITCH SETTINGS

10BASET/
10BASE2
CONVERTER

LAN
B

LAN
A

RX
TEST
CABLE

COMMUNICATIONS
TEST SET

IEEE 488
GPIB BUS

IN

TEST SET
INPUT/

OUTPUT
PORTS

OUT

NOTE:  IF BTS RX/TX SIGNALS ARE
DUPLEXED (4800E): BOTH THE TX AND RX
TEST CABLES CONNECT TO THE DUPLEXED
ANTENNA GROUP.

100–WATT (MIN)
NON–RADIATING

RF LOAD

2O DB PAD
(FOR 1.7/1.9 GHZ)

30 DB
DIRECTIONAL
COUPLER

EVEN
SECOND/SYNC
IN (BNC “T”
WITH 50 OHM
TERMINATOR)

CDMA
TIMEBASE

 IN

FREQ
MONITOR

SYNC
MONITOR

CSM

REF FW00096

Figure 3-13: Optimization/ATP Test Setup Calibration (CyberTest, HP 8935 and Advantest)

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSM BOARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSM BOARD

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSM BOARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSM BOARD

RF
OUT
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RF OUT
ONLY

Hewlett–Packard Model HP 8921A W/PCS Interface
(for  1700 and 1900 MHz)

HP PCS
INTERFACE*

GPIB
CONNECTS
TO BACK OF

UNITS

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSM BOARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSM BOARD

TEST SETS Optimization/ATP SET UP

RX ANTENNA
PORT OR RFDS
RX ANTENNA
DIRECTIONAL

COUPLER

TX ANTENNA
PORT OR RFDS
RX ANTENNA
DIRECTIONAL

COUPLER

RS232–GPIB
INTERFACE BOX

INTERNAL PCMCIA
ETHERNET CARD

GPIB
CABLE

UNIVERSAL TWISTED
PAIR (UTP) CABLE

(RJ45 CONNECTORS)

RS232 NULL
MODEM
CABLE

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

BTS

TX
TEST
CABLE

CDMA
LMF

DIP SWITCH SETTINGS

10BASET/
10BASE2
CONVERTER

LAN
B

LAN
A

RX
TEST
CABLE

COMMUNICATIONS
TEST SET

IEEE 488
GPIB BUS

IN

TEST SET
INPUT/

OUTPUT
PORTS

OUT

NOTE:  IF BTS RX/TX SIGNALS ARE
DUPLEXED (4800E): BOTH THE TX AND RX
TEST CABLES CONNECT TO THE DUPLEXED
ANTENNA GROUP.

100–WATT (MIN)
NON–RADIATING

RF LOAD

2O DB PAD 
(FOR 1.7/1.9 GHZ)

EVEN
SECOND/SYNC
IN (BNC “T”
WITH 50 OHM
TERMINATOR)

CDMA
TIMEBASE

 IN

FREQ
MONITOR

SYNC
MONITOR

CSM

RF
IN/OUT

Figure 3-14: Optimization/ATP Test Setup HP 8921A

REF FW00097

GPIB
CONNECTS
TO BACK OF

UNIT

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSM BOARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSM BOARD

Hewlett–Packard Model HP 8921A
(for 800 MHz)

* FOR 1700 AND
1900 MHZ ONLY

30 DB
DIRECTIONAL
COUPLER

RF
IN/OUT

RF OUT
ONLY
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Figure 3-15: Typical TX ATP Setup with Directional Coupler (shown with and without RFDS)

30 DB
DIRECTIONAL

COUPLER

40W NON–RADIATING
RF LOAD

OUTPUT
PORT

RVS (REFLECTED)
PORT 50–OHM
TERMINATION

FWD
(INCIDENT)

PORT

BTS INPUT
PORT

TX TEST
CABLE

ONE 20 DB 20 W IN LINE
ATTENUATOR

Connect TX test cable between
the directional coupler input port
and the  appropriate TX antenna
directional coupler connector.

TX ANTENNA DIRECTIONAL COUPLERS

RFDS RX (RFM TX) COUPLER
OUTPUTS TO RFDS FWD(BTS)
ASU2  (SHADED) CONNECTORS

RX
(RFM TX)

TX
(RFM RX)

COBRA RFDS Detail

1
2

3

RF FEED LINE  TO
DIRECTIONAL
COUPLER
REMOVED

COMMUNICATIONS
TEST SET

IN

Appropriate test sets and the port
names for all model test sets are
described in Table 3-22.

TX
TEST
CABLE

TX RF FROM BTS FRAME

TEST
DIRECTIONAL
COUPLER

NOTE:
THIS SETUP APPLIES TO BOTH
STARTER AND EXPANSION FRAMES.

FW00116
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Figure 3-16: Typical RX ATP Setup with Directional Coupler (shown with or without RFDS)

RX RF FROM BTS
FRAME

3
4

1
2

5
6

Connect RX test cable between
the test set and the  appropriate
RX antenna directional coupler.

RX ANTENNA DIRECTIONAL COUPLERS

RF FEED LINE  TO
TX ANTENNA
REMOVED

COMMUNICATIONS
TEST SET

RFDS TX (RFM RX) COUPLER
OUTPUTS TO RFDS FWD(BTS)
ASU1 (SHADED) CONNECTORS

RX
(RFM TX)

TX
(RFM RX)

COBRA RFDS Detail

OUT

Appropriate test sets and the port
names for all model test sets are
described in Table 3-22.

RX Test
Cable

NOTE:
THIS SETUP APPLIES TO BOTH
STARTER AND EXPANSION FRAMES.

FW00115
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Test Set Calibration
Background

Proper test equipment calibration ensures that the test equipment and
associated test cables do not introduce measurement errors, and that
measurements are correct.

If the test set being used to interface with the BTS has been
calibrated and maintained as a set, this procedure does not
need to be performed. (Test Set includes LMF terminal,
communications test set, additional test equipment,
associated test cables, and adapters.)

NOTE

This procedure must be performed prior to beginning the optimization.
Verify all test equipment (including all associated test cables and
adapters actually used to interface all test equipment and the BTS) has
been calibrated and maintained as a set.

If any piece of test equipment, test cable, or RF adapter,
that makes up the calibrated test equipment set, has been
replaced, re-calibration must be performed. Failure to do so
can introduce measurement errors, resulting in incorrect
measurements and degradation to system performance.

CAUTION

Calibration of the communications test set (or equivalent
test equipment) must be performed at the site before
calibrating the overall test set. Calibrate the test equipment
after it has been allowed to warm–up and stabilize for a
minimum of 60 minutes.

IMPORTANT

*

Purpose of Test Set
Calibration

These procedures access the LMF automated calibration routine used to
determine the path losses of the supported communications analyzer,
power meter, associated test cables, and (if used) antenna switch that
make up the overall calibrated test set. After calibration, the gain/loss
offset values are stored in a test measurement offset file on the LMF.
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Selecting Test Equipment

Use LMF Options from the Options menu list to select test equipment
automatically (using the autodetect feature) or manually.

A Serial Connection and a Network Connection tab are provided for
test equipment selection. The Serial Connection tab is used when the
test equipment items are connected directly to the LMF computer via a
GPIB box (normal setup). The Network Connection tab is used when
the test equipment is to be connected remotely via a network connection.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� Test equipment is correctly connected and turned on.

� CDMA LMF computer serial port and test equipment are connected to
the GPIB box.

Manually Selecting Test
Equipment in a Serial
Connection Tab

Test equipment can be manually specified before, or after, the test
equipment is connected. The LMF does not check to see if the test
equipment is actually detected for manual specification. Follow the
procedure in Table 3-23 to select test equipment manually.

Table 3-23: Selecting Test Equipment Manually in a Serial Connection Tab

� Step Action

1 From the Options menu, select LMF Options.

The LMF Options window appears.

2 Click on the Serial Connection tab (if not in the forefront).

3 Select the correct serial port in the COMM Port pick list (normally COM1).

4 Click on the Manual Specification button (if not enabled).

5 Click on the check box corresponding to the test item(s) to be used.

6 Type the GPIB address in the corresponding GPIB address box.

Recommended Addresses
13=Power Meter
18=CDMA Analyzer

7 Click on Apply. (The button darkens until the selection has been committed.)

NOTE
With manual selection, the LMF does not detect the test equipment to see if it is connected and
communicating with the LMF.

8 Click on Dismiss to close the test equipment window.
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Automatically Selecting Test
Equipment in a Serial
Connection Tab

When using the auto-detection feature to select test equipment, the LMF
examines which test equipment items are actually communicating with
the LMF. Follow the procedure in Table 3-24 to use the auto-detect
feature.

Table 3-24: Selecting Test Equipment Using Auto-Detect

� Step Action

1 From the Options menu, select LMF Options.

The LMF Options window appears.

2 Click on the Serial Connection tab (if not in the forefront).

3 Select the correct serial port in the COMM Port pick list (normally COM1).

4 Click on Auto–Detection (if not enabled).

5 Type in the GPIB addresses in the box labeled GPIB address to search (if not already displayed).

NOTE
When both a power meter and analyzer are selected, the first item listed in the GPIB addresses to
search box is used for RF power measurements (i.e., TX calibration). The address for a power
meter is normally 13 and the address for a CDMA analyzer is normally 18. If 13,18 is included in
the GPIB addresses to search box, the power meter (13) is used for RF power measurements. If
the test equipment items are manually selected the CDMA analyzer is used only if a power meter
is not selected.

6 Click on Apply.

NOTE
The button darkens until the selection has been committed. A check mark appears in the Manual
Configuration section for detected test equipment items.

7 Click Dismiss to close the LMF Options window.
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Calibrating Test Equipment

The calibrate test equipment function zeros the power measurement level
of the test equipment item that is to be used for TX calibration and audit.
If both a power meter and an analyzer are connected, only the power
meter is zeroed.

Use the Calibrate Test Equipment menu item from the Util menu to
calibrate test equipment. The test equipment must be selected before
calibration can begin. Follow the procedure in Table 3-25 to calibrate the
test equipment.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� Test equipment to be calibrated has been connected correctly for tests
that are to be run.

� Test equipment has been selected.

Table 3-25: Test Equipment Calibration

� Step Action

1 From the Util menu, select Calibrate Test Equipment.

A Directions window is displayed.

2 Follow the directions provided.

3 Click on Continue to close the Directions window.

A status report window is displayed.

4 Click on OK to close the status report window.

Calibrating Cables

The cable calibration function measures the loss (in dB) for the TX and
RX cables that are to be used for testing. A CDMA analyzer is used to
measure the loss of each cable configuration (TX cable configuration and
RX cable configuration). The cable calibration consists of the following:

� Measuring the loss of a short cable – This is required to compensate
for any measurement error of the analyzer. The short cable (used only
for the calibration process) is used in series with both the TX and RX
cable configuration when measuring. The measured loss of the short
cable is deducted from the measured loss of the TX and RX cable
configuration to determine the actual loss of the TX and RX cable
configurations. The result is then adjusted out of both the TX and RX
measurements to compensate for the measured loss.

� The short cable plus the RX cable configuration loss is measured –
The RX cable configuration normally consists only of a coax cable
with type-N connectors that is long enough to reach from the BTS RX
port of the test equipment.

 . . . continued on next page
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� The short cable plus the TX cable configuration loss is measured –
The TX cable configuration normally consists of two coax cables with
type-N connectors and a directional coupler, a load, and an additional
attenuator (if required by the specified BTS). The total loss of the path
loss of the TX cable configuration must be as required for the BTS
(normally 30 or 50 dB).

Calibrating Cables with a
CDMA Analyzer

Cable Calibration is used to calibrate both TX and RX test cables.
Follow the procedure in Table 3-26 to calibrate the cables. Figure 3-10
illustrates the cable calibration test equipment setup. Appendix F covers
the procedures for manual cable calibration.

LMF cable calibration for PCS systems (1.7/1.9 GHz)
cannot be accomplished using an HP8921 analyzer with
PCS interface or an Advantest analyzer. A different
analyzer type or the signal generator and spectrum analyzer
method must be used (refer to Table 3-27 and Figure 3-17).
Cable calibration values are then manually entered.

NOTE

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� Test equipment to be calibrated has been connected correctly for cable
calibration.

� Test equipment has been selected and calibrated.

Table 3-26: Cable Calibration

� Step Action

1 From the Util menu, select Cable Calibration.

A Cable Calibration window is displayed.

2 Enter a channel number(s) in the Channels box.

NOTE
Multiple channels numbers must be separated with a comma, no space (i.e., 200,800). When two
or more channels numbers are entered, the cables are calibrated for each channel. Interpolation is
accomplished for other channels as required for TX calibration.

3 Select TX and RX Cable Cal, TX Cable Cal, or RX Cable Cal in the Cable Calibration pick
list.

4 Click OK. Follow the direction displayed for each step.

A status report window displays the results of the cable calibration.
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Calibrating TX Cables Using a
Signal Generator and
Spectrum Analyzer

Follow the procedure in Table 3-27 to calibrate the TX cables using a
signal generator and spectrum analyzer. Refer to Figure 3-17 for a
diagram of the signal generator and spectrum analyzer.

Table 3-27: Calibrating TX Cables Using Signal Generator and Spectrum Analyzer

� Step Action

1 Connect a short test cable between the spectrum analyzer and the signal generator.

2 Set signal generator to 0 dBm at the customer frequency of:

– 869–894 MHz for 800 MHz CDMA

– 1930–1990 MHz for North American PCS.

– 1840–1870 MHz for KoreaN PCS

3 Use a spectrum analyzer to measure signal generator output (see Figure 3-17, A) and record the
value.

4 Connect the spectrum analyzer’s short cable to point B, (as shown in the lower right portion of the
diagram) to measure cable output at customer frequency of:

– 869–894 MHz for 800 MHz CDMA

– 1930–1990 MHz for North American PCS.

– 1840–1870 MHz for Korean PCS

Record the value at point B.

5 Calibration factor = A – B
Example: Cal = –1 dBm – (–53.5 dBm) = 52.5 dB

NOTE
The short cable is used for calibration only. It is not part of the final test setup. After calibration is
completed, do not re-arrange any cables. Use the equipment setup, as is, to ensure test procedures
use the correct calibration factor.
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Figure 3-17: Calibrating Test Equipment Setup for TX BLO and TX ATP Tests
(using Signal Generator and Spectrum Analyzer)
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Calibrating RX Cables Using a
Signal Generator and
Spectrum Analyzer

Follow the procedure in Table 3-28 to calibrate the RX cables using the
signal generator and spectrum analyzer. Refer to Figure 3-18, if required.

Table 3-28: Calibrating RX Cables Using a Signal Generator and Spectrum Analyzer

� Step Action

1 Connect a short test cable to the spectrum analyzer and connect the other end to the Signal
Generator.

2 Set signal generator to –10 dBm at the customer’s RX frequency of:

– 824–849 for 800 MHz CDMA

– 1850–1910 MHz band for North American PCS

– 1750–1780 MHz for Korean PCS

3 Use spectrum analyzer to measure signal generator output (see Figure 3-18, A) and record the
value for A.

4 Connect the test setup, as shown in the lower portion of the diagram to measure the output at the
customer’s RX frequency of:

– 824–849 for 800 MHz CDMA

– 1850–1910 MHz band for North American PCS

– 1750–1780 MHz for Korean PCS

Record the value at point B.

. . . continued on next page
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Table 3-28: Calibrating RX Cables Using a Signal Generator and Spectrum Analyzer

� ActionStep

5 Calibration factor = A – B
Example: Cal = –12 dBm – (–14 dBm) = 2 dBm

NOTE
The short test cable is used for test equipment setup calibration only. It is not be part of the final
test setup. After calibration is completed, do not re-arrange any cables. Use the equipment setup,
as is, to ensure test procedures use the correct calibration factor.

 

Figure 3-18: Calibrating Test Equipment Setup for RX ATP Test
(using Signal Generator and Spectrum Analyzer)
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Setting Cable Loss Values
Cable loss values for the TX and RX test cable configurations are
normally set by accomplishing cable calibration using the applicable test
equipment. The resulting values are stored in the cable loss files. The
cable loss values can also be set/changed manually. Follow the procedure
in Table 3-29 to set cable loss values.

Prerequisites

� Logged into the BTS

Table 3-29: Setting Cable Loss Values

Step Action

1 Click on the Util menu.

2 Select Edit>Cable Loss>TX or RX.

A data entry pop–up window appears.

3 To add a new channel number, click on the Add Row button, then click in the Channel # and Loss
(dBm) columns and enter the desired values.

4 To edit existing values, click in the data box to be changed and change the value.

5 To delete a row, click on the row and then click on the Delete Row button.

6 To save displayed values, click on the Save button.

7 To exit the window, click on the Dismiss button.

Values entered/changed after the Save button was used are not saved.

NOTE
� If cable loss values exist for two different channels, the LMF will interpolate for all other channels.

� Entered values are used by the LMF as soon as they are saved. You do not have to logout and login.
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Setting TX Coupler Loss Value
If an in–service TX coupler is installed, the coupler loss (e.g., 30 dB)
must be manually entered so it will be included in the LMF TX
calibration and audit calculations. Follow the procedure in Table 3-30 to
set TX coupler loss values.

Prerequisites

� Logged into the BTS.

Table 3-30: Setting TX Coupler Loss Value

Step Action

1 Click on the Util menu.

2 Select Edit>TX Coupler Loss. A data entry pop–up window appears.

3 Click in the Loss (dBm) column for each carrier that has a coupler and enter the appropriate value.

4 To edit existing values click in the data box to be changed and change the value.

5 Click on the Save button to save displayed values.

6 Click on the Dismiss button to exit the window.

Values entered/changed after the Save button was used are not saved.

NOTE
� The In–Service Calibration check box in the Options>LMF Options>BTS Options tab must

checked before entered TX coupler loss values are used by the TX calibration and audit functions.

� Entered values are used by the LMF as soon as they are saved. You do not have to logout and login.
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Introduction to Bay Level
Offset Calibration

Calibration compensates for normal equipment variations within the
BTS and assures maximum measurement accuracy.

RF Path Bay Level Offset
Calibration

Calibration identifies the accumulated gain in every transmit path (BBX
slot) at the BTS site and stores that value in a BLO database calibration
table in the LMF. The BLOs are subsequently downloaded to each BBX.

For starter frames, each receive path starts at a BTS RX antenna port and
terminates at a backplane BBX slot. Each transmit path starts at a BBX
backplane slot, travels through the LPA, and terminates at a BTS TX
antenna port.

For expansion frames each receive path starts at the BTS RX port of the
cell site starter frame, travels through the frame-to-frame expansion
cable, and terminates at a backplane BBX slot of the expansion frame.
The transmit path starts at a BBX backplane slot of the expansion frame,
travels though the LPA, and terminates at a BTS TX antenna port of the
same expansion frame.

Calibration identifies the accumulated gain in every transmit path (BBX
slot) at the BTS site and stores that value in a BLO database. Each
transmit path starts at a C–CCP shelf backplane BBX slot, travels
through the LPA, and ends at a BTS TX antenna port. When the TX path
calibration is performed, the RX path BLO is automatically set to the
default value.

At omni sites, BBX slots 1 and 13 (redundant) are tested. At sector sites,
BBX slots 1 through 12, and 13 (redundant) are tested. Only those slots
(sectors) actually equipped in the current CDF are tested, regardless of
physical BBX board installation in the slot.

When to Calibrate BLOs
Calibration of BLOs is required:

� After initial BTS installation

� Once each year

� After replacing any of the following components or associated
interconnecting RF cabling:

– BBX board

– C–CCP shelf

– CIO card

– CIO to LPA backplane RF cable

– LPA backplane

– LPA
 . . . continued on next page
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– TX filter / TX filter combiner

– TX thru-port cable to the top of frame

TX Path Calibration

The TX Path Calibration assures correct site installation, cabling, and the
first order functionality of all installed equipment. The proper function
of each RF path is verified during calibration. The external test
equipment is used to validate/calibrate the TX paths of the BTS.

Before installing any test equipment directly to any TX
OUT connector you must first verify that there are no
CDMA channels keyed. Have the OMC–R place the sector
assigned to the LPA under test OOS. Failure to do so can
result in serious personal injury and/or equipment damage.

WARNING

Always wear a conductive, high impedance wrist strap
while handling any circuit card/module. If this is not done,
there is a high probability that the card/module could be
damaged by ESD.

CAUTION

At new site installations, to facilitate the complete test of
each CCP shelf (if the shelf is not already fully populated
with BBX boards), move BBX boards from shelves
currently not under test and install them into the empty
BBX slots of the shelf currently being tested to insure that
all BBX TX paths are tested.

– This procedure can be bypassed on operational sites
that are due for periodic optimization.

– Prior to testing, view the CDF file to verify the
correct BBX slots are equipped. Edit the file as
required to include BBX slots not currently equipped
(per Systems Engineering documentation).

IMPORTANT

*
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BLO Calibration Data File

During the calibration process, the LMF creates a bts–n.cal calibration
(BLO) offset data file in the bts–n folder. After calibration has been
completed, this offset data must be downloaded to the BBXs using the
Download BLO function. An explanation of the file is shown below.

Due to the size of the file, Motorola recommends that you
print out a hard copy of a bts.cal file and refer to it for the
following descriptions.

NOTE

The CAL file is subdivided into sections organized on a per slot basis (a
slot Block).

Slot 1 contains the calibration data for the 12 BBX slots. Slot 20
contains the calibration data for the redundant BBX. Each BBX slot
header block contains:

� A creation Date and Time – broken down into separate parameters of
createMonth, createDay, createYear, createHour, and createMin.

� The number of calibration entries – fixed at 720 entries corresponding
to 360 calibration points of the CAL file including the slot header and
actual calibration data.

� The calibration data for a BBX is organized as a large flat array. The
array is organized by branch, sector, and calibration point.

– The first breakdown of the array indicates which branch the
contained calibration points are for. The array covers transmit, main
receive and diversity receive offsets as follows:

Table 3-31: BLO BTS.cal File Array Assignments

Range Assignment

C[1]–C[240] Transmit

C[241]–C[480] Main Receive

C[481]–C[720] Diversity Receive

Slot 385 is the BLO for the RFDS.

NOTE

 . . . continued on next page
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– The second breakdown of the array is per sector. Configurations
supported are Omni, 3–sector or 6–sector.

Table 3-32: BTS.cal File Array (Per Sector)

BBX Sectorization TX RX RX Diversity

Slot[1] (Primary BBXs 1 through 12)

1 (Omni) 3–Sector, C[1]–C[20] C[241]–C[260] C[481]–C[500]

2
3–Sector,

1st C[21]–C[40] C[261]–C[280] C[501]–C[520]

3 6 Sector, Carrier C[41]–C[60] C[281]–C[300] C[521]–C[540]

4
1st

Carrier 3–Sector, C[61]–C[80] C[301]–C[320] C[541]–C[560]

5
Carrier 3–Sector,

3rd C[81]–C[100] C[321]–C[340] C[561]–C[580]

6 Carrier C[101]–C[120] C[341]–C[360] C[581]–C[600]

7 3–Sector, C[121]–C[140] C[361]–C[380] C[601]–C[620]

8
3–Sector,

2nd C[141]–C[160] C[381]–C[400] C[621]–C[640]

9 6 Sector, Carrier C[161]–C[180] C[401]–C[420] C[641]–C[660]

10
2nd

Carrier 3–Sector, C[181]–C[200] C[421]–C[440] C[661]–C[680]

11
Carrier 3–Sector,

4th C[201]–C[220] C[441]–C[460] C[681]–C[700]

12 Carrier C[221]–C[240] C[461]–C[480] C[701]–C[720]

Slot[20]] (Redundant BBX–13)

1 (Omni) 3–Sector, C[1]–C[20] C[241]–C[260] C[481]–C[500]

2
3–Sector,

1st C[21]–C[40] C[261]–C[280] C[501]–C[520]

3 6 Sector, Carrier C[41]–C[60] C[281]–C[300] C[521]–C[540]

4
1st

Carrier 3–Sector, C[61]–C[80] C[301]–C[320] C[541]–C[560]

5
Carrier 3–Sector,

3rd C[81]–C[100] C[321]–C[340] C[561]–C[580]

6 Carrier C[101]–C[120] C[341]–C[360] C[581]–C[600]

7 3–Sector, C[121]–C[140] C[361]–C[380] C[601]–C[620]

8
3–Sector,

2nd C[141]–C[160] C[381]–C[400] C[621]–C[640]

9 6 Sector, Carrier C[161]–C[180] C[401]–C[420] C[641]–C[660]

10
2nd

Carrier 3–Sector, C[181]–C[200] C[421]–C[440] C[661]–C[680]

11
Carrier 3–Sector,

4th C[201]–C[220] C[441]–C[460] C[681]–C[700]

12 Carrier C[221]–C[240] C[461]–C[480] C[701]–C[720]

� Ten calibration points per sector are supported for each branch. Two
entries are required for each calibration point.

� The first value (all odd entries) refer to the CDMA channel
(frequency) where the BLO is measured. The second value (all even
entries) is the power set level. The valid range for PwrLvlAdj is from
2500 to 27500 (2500 corresponds to –125 dBm and 27500
corresponds to +125 dBm).

 . . . continued on next page
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� The 20 calibration entries for each sector/branch combination must be
stored in order of increasing frequency. If less than 10 points
(frequencies) are calibrated, the largest frequency that is calibrated is
repeated to fill out the 10 points.

Example:
C[1]=384, odd cal entry

=   1 ‘‘calibration point”
C[2]=19102, even cal entry
C[3]=777,
C[4]=19086,
.
.
C[19]=777,
C[20]=19086, (since only two cal points were calibrated this 

would be repeated for the next 8 points)

� When the BBX is loaded with image = data, the cal file data for the
BBX is downloaded to the device in the order it is stored in the cal
file. TxCal data is sent first, C[1] – C[240]. Sector 1’s ten calibration
points are sent (C[1] – C[20]) followed by sector 2’s ten calibration
points (C[21] – C[40]), etc. The RxCal data is sent next (C[241] –
C[480]), followed by the RxDCal data (C[481] – C[720]).

� Temperature compensation data is also stored in the cal file for each
set.

Test Equipment Setup:
RF Path Calibration

Follow the procedure in Table 3-33 to set up test equipment.

Table 3-33: Test Equipment Setup (RF Path Calibration)

Step Action

NOTE
Verify the GPIB controller is properly connected and turned on.

! CAUTION
To prevent damage to the test equipment, all transmit (TX) test connections must be via the 30 dB
directional coupler for 800 MHz with an additional 20 dB in–line attenuator for 1.7/1.9 GHz.

1 Connect the LMF computer terminal to the BTS LAN A connector on the BTS (if you have not
already done so). Refer to the procedure in Table 3–2 on page 3-6.

� If required, calibrate the test equipment per the procedure in Table 3-25 on page 3-57.

� Connect the test equipment as shown in Figure 3-11 and Figure 3-12 starting on page 3-48.
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TX Path Calibration

The assigned channel frequency and power level (as measured at the top
of the frame) for transmit calibration are derived from the site CDF files.
For each BBX, the channel frequency is specified in the ChannelList
CDF file parameter and the power is specified in the SIFPilotPwr
CDF file parameter for the sector associated with the BBX (located
under the ParentSECTOR field of the ParentCARRIER CDF file
parameter).

If both the BTS–x.cdf and CBSC–x.cdf files are current,
all information will be correct on the LMF. If not, the
carrier and channel will have to be set for each test.

NOTE

The calibration procedure attempts to adjust the power to within +0.5 dB
of the desired power. The calibration will pass if the error is less than
+1.5 dB.

The TX Bay Level Offset at sites WITHOUT the directional coupler
option, is approximately 42.0 dB ±3.0 dB.

� At sites WITHOUT RFDS option, BLO is approximately 
42.0 dB ±4.0 dB. A typical example would be TX output power
measured at BTS (36.0 dBm) minus the BBX TX output level
(approximately –6.0 dBm) would equate to 42 dB BLO.

The TX Bay Level Offset at sites WITH the directional coupler option,
is approximately 41.4 dB ±3.0 dB. TX BLO = Frame Power Output
minus BBX output level.

� Example: TX output power measured at RFDS TX coupler
(39.4 dBm) minus the BBX TX output level (approximately
–2.0 dBm) and RFDS directional coupler/cable (approximately
–0.6 dBm) would equate to 41.4 dB BLO.

The LMF Tests menu list items, TX Calibration and All Cal/Audit,
perform the TX BLO Calibration test for a XCVR(s). The All Cal/Audit
menu item performs TX calibration, downloads BLO, and performs TX
audit if the TX calibration passes. All measurements are made through
the appropriate TX output connector using the calibrated TX cable setup.

Prerequisites

Before running this test, ensure that the following have been done:

� CSM–1, GLIs, MCCs, and BBXs have correct code load and data
load.

� Primary CSM and MGLI are INS.

� All BBXs are OOS_RAM.

� Test equipment and test cables are calibrated and connected for TX
BLO calibration.

� LMF is logged into the BTS.
 . . . continued on next page
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Connect the test equipment as shown in Figure 3-11 and Figure 3-12 and
follow the procedure in Table 3-34 to perform the TX calibration test.

Before installing any test equipment directly to any TX
OUT connector, first verify there are no CDMA BBX
channels keyed. Failure to do so can result in serious
personal injury and/or equipment damage.

WARNING

Verify all BBX boards removed and repositioned have been
returned to their assigned shelves/slots. Any BBX boards
moved since they were downloaded will have to be
downloaded again.

IMPORTANT

*

Follow the procedure in Table 3-34 to perform the TX calibration test.

Table 3-34: BTS TX Path Calibration

� Step Action

1 Select the BBX(s) to be calibrated.

2 From the Tests menu, select TX Calibration or All Cal/Audit.

3 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list. (Press and hold the
<Shift> or <Ctrl> key to select multiple items.)

4 Type the appropriate channel number in the Carrier n Channels box.

5 Click on OK.

6 Follow the cable connection directions as they are displayed.

A status report window displays the test results.

7 Click on Save Results or Dismiss to close the status report window.

Exception Handling

In the event of a failure, the calibration procedure displays a FAIL
message in the status report window and provides information in the
Description field.

Recheck the test setup and connection and re–run the test. If the tests fail
again, note specifics about the failure, and refer to Chapter 6,
Troubleshooting.
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Download BLO Procedure

After a successful TX path calibration, download the bay level offset
(BLO) calibration file data to the BBXs. BLO data is extracted from the
CAL file for the Base Transceiver Subsystem (BTS) and downloaded to
the selected BBX devices.

If a successful All Cal/Audit was completed, this
procedure does not need to be performed, as BLO is
downloaded as part of the All Cal/Audit.

NOTE

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� BBXs being downloaded are OOS–RAM (yellow).

� TX calibration is successfully completed.

Follow the procedure in Table 3-35 to download the BLO data to the
BBXs.

Table 3-35: Download BLO

� Step Action

1 Select the BBX(s) to be downloaded.

2 From the Device menu, select Download BLO.

A status report window displays the result of the download.

NOTE
Selected device(s) do not change color when BLO is downloaded.

3 Click on OK to close the status report window.

Calibration Audit Introduction

The BLO calibration audit procedure confirms the successful generation
and storage of the BLO calibration offsets. The calibration audit
procedure measures the path gain or loss of every BBX transmit path at
the site. In this test, actual system tolerances are used to determine the
success or failure of a test. The same external test equipment set up is
used.

* RF path verification, BLO calibration, and BLO data
download to BBXs must have been successfully completed
prior to performing the calibration audit.

IMPORTANT
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TX Path Audit

Perform the calibration audit of the TX paths of all equipped BBX slots,
per the procedure in Table 3-36

Before installing any test equipment directly to any TX
OUT connector, first verify there are no CDMA BBX
channels keyed. Failure to do so can result in serious
personal injury and/or equipment damage.

WARNING

If a successful All Cal/Audit was completed, this
procedure does not need to be performed, as BLO is
downloaded as part of the All Cal/Audit.

NOTE

TX Audit Test

The Tests menu item, TX Audit, performs the TX BLO Audit test for a
BBX(s). All measurements are made through the appropriate TX output
connector using the calibrated TX cable setup.

Prerequisites

Before running this test, ensure that the following have been done:

� CSM–1, GLI2s, and BBXs have correct code load and data load.

� Primary CSM and MGLI are INS.

� All BBXs are OOS_RAM.

� Test equipment and test cables are calibrated and connected for TX
BLO calibration.

� LMF is logged into the BTS.

Connect the test equipment as shown in Figure 3-11 and Figure 3-12.
Follow the procedure in Table 3-36 to perform the BTS TX Path Audit
test.

 . . . continued on next page
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Table 3-36: BTS TX Path Audit

� Step Action

1 Select the BBX(s) to be audited.

2 From the Tests menu, select TX Audit.

3 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list.

Press and hold the <Shift> or <Ctrl> key to select multiple items.

4 Type the appropriate channel number in the Carrier n Channels box.

5 Click on OK.

6 Follow the cable connection directions as they are displayed.

A status report window displays the test results.

7 Click on Save Results or Dismiss to close the status report window.

Exception Handling

In the event of a failure, the calibration procedure displays a FAIL
message in the Status Report window and provides information in the
Description field. Recheck the test setup and connection and re–run the
test. If the tests fail again, note specifics about the failure, and refer to
Chapter 6, Troubleshooting.

All Cal/Audit Test

The Tests menu item, All Cal/Audit, performs the TX BLO Calibration
and Audit test for a XCVR(s). All measurements are made through the
appropriate TX output connector using the calibrated TX cable setup.

If the TX calibration portion of the test passes, the BLO
data is automatically downloaded to the BBX(s) before the
audit portion of the test is run.

NOTE

 . . . continued on next page
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Prerequisites

Before running this test, ensure that the following have been done:

� CSM–1, GLI2s, BBXs have correct code and data loads.

� Primary CSM and MGLI2 are INS.

� All BBXs are OOS_RAM.

� Test equipment and test cables are calibrated and connected for TX
BLO calibration.

� LMF is logged into the BTS.

Follow the procedure in Table 3-37 to perform the All Cal/Audit test.

Before installing any test equipment directly to any TX
OUT connector, first verify there are no CDMA BBX
channels keyed. Failure to do so can result in serious
personal injury and/or equipment damage.

WARNING

Table 3-37: All Cal/Audit Test

� Step Action

1 Select the BBX(s) to be tested.

2 From the Tests menu, select All Cal/Audit.

3 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list.

Press and hold the <Shift> or <Ctrl> key to select multiple items.

4 Type the appropriate channel number in the Carrier n Channels box.

5 Click on OK.

6 Follow the cable connection directions as they are displayed.

A status report window displays the test results.

7 Click on Save Results or Dismiss to close the status report window.
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Create CAL File

The Create Cal File function gets the BLO data from BBXs and
creates/updates the CAL file for the BTS. If a CAL file does not exist, a
new one is created. If a CAL file already exists, it is updated. After a
BTS has been fully optimized, a copy of the CAL file must exist so it
can be transferred to the CBSC. If TX calibration has been successfully
performed for all BBXs and BLO data has been downloaded, a CAL file
exists. Note the following:

� The Create Cal File function only applies to selected (highlighted)
BBXs.

The user is not encouraged to edit the CAL file as this
action can cause interface problems between the BTS and
the LMF. To manually edit the CAL file, you must first
logout of the BTS. If you manually edit the CAL file and
then use the Create Cal File function, the edited
information is lost.

WARNING

Prerequisites

Before running this test, the following should be done:

� LMF is logged into the BTS.

� BBXs are OOS_RAM with BLO downloaded.

Table 3-38: Create CAL File

� Step Action

1 Select the applicable BBXs.

NOTE
The CAL file is only updated for the selected BBXs.

2 Click on the Device menu.

3 Click on the Create Cal File menu item.

A status report window displays the results of the action.

4 Click OK to close the status report window.
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RFDS Description

The RFDS is not available for the –48 V BTS at the time
of this publication.

NOTE

The optional RFDS performs RF tests of the site from the CBSC or from
an LMF. The RFDS consists of the following elements:

� Antenna Select Unit (ASU)

� FWT Interface Card (FWTIC)

� Subscriber Unit Assembly (SUA)

For complete information regarding the RFDS, refer to the CDMA RFDS
Hardware Installation manual and CDMA RFDS User’s Guide.

The LMF provides the following functions for RFDS equipment:

� TX and RX Calibration

� Dekey Test Subscriber Unit (TSU)

� Download Test Subscriber Interface Card (TSIC)

� Forward Test

� Key TSU

� Measure TSU Receive Signal Strength Indication (RSSI)

� Ping TSU

� Program TSU Number Assignment Module (NAM)

� Reverse Test

� RGLI actions (for GLI based RFDS units)

� Set ASU

� Status TSU
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RFDS Parameter Settings

The bts-#.cdf  file includes RFDS parameter settings that must
match the installed RFDS equipment. The paragraphs below describe the
editable parameters and their defaults. Table 3-39 explains how to edit
the parameter settings.

� RfdsEquip – valid inputs are 0 through 2.
0 = (default) RFDS is not equipped
1 = Non-Cobra/Patzer box RFDS
2 = Cobra RFDS

� TsuEquip – valid inputs are 0 or 1
0 = (default) TSU not equipped
1 = TSU is equipped in the system

� MC1....4 – valid inputs are 0 or 1
0 = (default) Not equipped
1 = Multicouplers equipped in RFDS system 

(9600 system RFDS only)

� Asu1/2Equip – valid inputs are 0 or 1
0 = (default) Not equipped
1 = Equipped

� TestOrigDN – valid inputs are ’’’ (default) or a numerical string up to
15 characters. (This is the phone number the RFDS dials when
originating a call. A dummy number needs to be set up by the switch,
and is to be used in this field.)

Any text editor supporting the LMF may be used to open
any text files to verify, view, or modify data.

NOTE

 . . . continued on next page
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Table 3-39: RFDS Parameter Settings

Step Action

* IMPORTANT
Log out of the BTS prior to performing this procedure.

1 Using a text editor, verify the following fields are set correctly in the bts–#.cdf  file
(1 = GLI based RFDS; 2 = Cobra RFDS).

EXAMPLE:
RfdsEquip = 2
TsuEquip = 1
MC1Equip = 0
MC2Equip = 0
MC3Equip = 0
MC4Equip = 0
Asu1Equip = 1
Asu2Equip = 0 (1 if system is non-duplexed)
TestOrigDN = ’123456789’’

NOTE
The above is an example of the bts-#.cdf  file that should have been generated by the OMC and
copied to the LMF. These fields will have been set by the OMC if the RFDSPARM database is
modified for the RFDS.

2 Save and/or quit the editor. If any changes were made to these fields, data will need to be downloaded
to the GLI2 (see Step 3, otherwise proceed to Step 4).

3 To download to the GLI2, click on the Device menu and select the Download Data menu item
(selected devices do not change color when data is downloaded).

A status report window displays the status of the download.

Click OK to close the status report window.

! CAUTION
After downloading data to the GLI2, the RFDS LED slowly begins flashing red and green for
approximately 2–3 minutes. DO NOT attempt to perform any functions with the RFDS until the LED
remains green.

4 Status the RFDS TSU.

A status report window displays the software version number for the TSIC and SUA.

* IMPORTANT
If the LMF yields an error message, check the following:

� Ensure the AMR cable is correctly connected from the BTS to the RFDS.

� Verify the RFDS has power.

� Verify the RFDS status LED is green.

� Verify fields in the bts-#.cdf  file are correct (see Step 1).

� Status the MGLI and ensure the device is communicating (via Ethernet) with the LMF, and the
device is in the proper state (INS).
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RFDS TSU NAM Programming

The RFDS TSU NAM must be programmed with the appropriate system
parameters and phone number during hardware installation. The TSU
phone and TSU MSI must be recorded for each BTS used for OMC–R
RFDS software configuration. The TSU NAM should be configured the
same way that any local mobile subscriber would use.

The user will only need to program the NAM for the initial
install of the RFDS.

NOTE

The NAM must be programmed into the SUA before it can receive and
process test calls, or be used for any type of RFDS test.

Explanation of Parameters
used when Programming the
TSU NAM

Table 3-40 defines the parameters used when editing the tsu.nam file.

Table 3-40: Definition of Parameters

Access_Overload_Code
Slot_Index
System ID
Network ID

These parameters are obtained from the switch.

Primary_Channel_A
Primary_Channel_B
Secondary_Channel_A
Secondary_Channel B

These parameters are the channels used in operation of the system.

Lock_Code
Security_Code
Service_Level
Station_Class_Mark

Do not change.

IMSI_11_12
IMSI_MCC

These fields can be obtained at the OMC using the following
command:
OMC000>disp bts–# imsi
If the fields are blank, replace the IMSI fields in the NAM file to 0,
otherwise use the values displayed by the OMC.

MIN_1 Phone Number This field is the phone number assigned to the mobile. The ESN and
MIN should be entered into the switch as well.

NOTE: This field is different from the TestOrigDN field in the
bts.cdf file. The MIN is the phone number of the RFDS subscriber,
and the TestOrigDN is the number is subscriber calls.
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Valid NAM Ranges

Table 3-41 provides the valid NAM field ranges. If any of the fields are
missing or out of range, the RFDS errors out.

Table 3-41: Valid NAM Field Ranges

Valid Range

NAM Field Name Minimum Maximum

Access_Overload_Code 0 15

Slot_Index 0 7

System ID 0 32767

Network ID 0 32767

Primary_Channel_A 25 1175

Primary_Channel_B 25 1175

Secondary_Channel_A 25 1175

Secondary_Channel_B 25 1175

Lock_Code 0 999

Security_Code 0 999999

Service_Level 0 7

Station_Class_Mark 0 255

IMSI_11_12 0 99

IMSI_MCC 0 999

MIN Phone Number N/A N/A
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Set Antenna Map Data

The antenna map data is only used for RFDS tests and is required if an
RFDS is installed. Antenna map data does not have to be entered if an
RFDS is not installed. The antenna map data must be entered manually.
Perform the procedure in Table 3-42 to set the Antenna Map Data.

Prerequisite

� Logged into the BTS

Table 3-42: Set Antenna Map Data

Step Action

1 Click on the Util menu.

2 Select Edit>Antenna Map>TX or RX.

A data entry pop–up window appears.

3 Enter/edit values as required for each carrier.

NOTE
Refer to the Util >Edit–antenna map LMF help screen for antenna map examples.

4 Click on the Save button to save displayed values.

NOTE
Entered values are used by the LMF as soon as they are saved. You do not have to logout and login.

5 Click on the Dismiss button to exit the window.

NOTE
Values entered/changed after using the Save button are not saved.
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Set RFDS Configuration Data

If an RFDS is installed, the RFDS configuration data must be manually
entered. Perform the procedure in Table 3-43 to set the RFDS
Configuration Data.

Prerequisite

� Logged into the BTS.

The entered antenna# index numbers must correspond to
the antenna# index numbers used in the antenna maps.

IMPORTANT

*

Table 3-43: Set RFDS Configuration Data

Step Action

1 Click on the Util menu.

2 Select Edit>RFDS Configuration>TX or RX.

A data entry pop–up window appears.

3 To add a new antenna number, click on the Add Row button, then click in the other columns and enter
the desired data.

4 To edit existing values, click in the data box to be changed and change the value.

NOTE
Refer to the Util >Edit–RFDS Configuration LMF help screen for RFDS configuration data
examples.

5 To delete a row, click on the row and click on the Delete Row button.

6 To save displayed values, click on the Save button.

NOTE
� Entered values are used by the LMF as soon as they are saved. You do not have to logout and login.

7 To exit the window, click on the Dismiss button .

NOTE
Values entered/changed after using the Save button are not saved.
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RFDS Calibration

The RFDS TX and RX antenna paths must be calibrated to ensure peak
performance. The RFDS calibration option calibrates the RFDS TX and
RX paths.

For a TX antenna path calibration, the BTS XCVR is keyed at a
pre–determined power level and the BTS power output level is measured
by the RFDS. The power level is then measured at the TX antenna
directional coupler by the power measuring test equipment item being
used (power meter or analyzer). The difference (offset) between the
power level at the RFDS and the power level at the TX antenna
directional coupler is used as the TX RFDS calibration offset value.

For an RX antenna path calibration, the RFDS is keyed at a
pre–determined power level and the power input level is measured by the
BTS XCVR. A CDMA signal at the same power level measured by the
BTS XCVR is then injected at the RX antenna directional coupler by the
RFDS keyed power level and the power level measured at the BTS
XCVR is the RFDS RX calibration offset value.

The TX and RX RFDS calibration offset values are written to the CAL
file.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� BBXs are INS_TEST.

� Cable calibration has been performed

� TX calibration has been performed and BLO has been downloaded for
the BTS.

� Test equipment has been connected correctly for a TX calibration.

� Test equipment has been selected and calibrated.

Follow the procedure in Table 3-44 to calibrate the TX and RX antenna
paths.

Table 3-44: RFDS Calibration Procedure

� Step Action

1 Select the RFDS tab.

2 Select the RFDS menu.

3 Select the RFDS Calibration menu item.

4 Select the appropriate direction (TX or RX) in the Direction pick list.

5 Type the appropriate channel number(s) in the Channel box.

NOTE
Separate channel numbers with a comma or dash (no spaces) if using more than one channel
number (e.g., 247,585,742 or 385–395 for numbers through and including).
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Table 3-44: RFDS Calibration Procedure

� ActionStep

6 Select the appropriate carrier(s) in the Carriers pick list.

NOTE
Use the <Shift> or <Ctrl> key to select multiple carriers.

7 Select the appropriate Rx branch (Main, Diversity or Both) in the RX Branch pick list.

8 Select the appropriate baud rate (1=9600, 2=14400) in the Rate Set pick list.

9 Click OK.

A status report window is displayed, followed by a Directions pop-up window.

10 Follow the cable connection directions as they are displayed.

A status report window displays the results of the actions.

11 Click on the OK button to close the status report window.

12 Click on the BTS tab.

13 Click on the MGLI.

14 Download the CAL file which has been updated with the RFDS offset data to the selected GLI
device by clicking on Device>Download Data from the tab menu bar and pulldown.

NOTE
The MGLI automatically transfers the RFDS offset data from the CAL file to the RFDS.

 

Program TSU NAM

Follow the procedure in Table 3-45 to program the TSU NAM. The
NAM must be programmed before it can receive and process test calls,
or be used for any type of RFDS test.

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� MGLI is INS.

� TSU is powered up and has a code load.

Table 3-45: Program the TSU NAM

Step Action

1 Select the RFDS tab.

2 Select the SUA (Cobra RFDS) or TSU (GLI based RFDS).

3 Click on the TSU menu.

4 Click on the Program TSU NAM menu item.

5 Enter the appropriate information in the boxes (see Table 3-40 and Table 3-41).

6 Click on the OK button to display the status report.

7 Click on the OK button to close the status report window.
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Objective

This section tests the redundancy options that could be included in the
cell site. These tests verify, under a fault condition, that all modules
equipped with redundancy switch operations to their redundant partner
and resume operation. An example would be to pull the currently active
CSM and verify the standby CSM takes over distribution of the CDMA
reference signal.

Redundancy covers many BTS modules. Confirm the redundant options
included in the BTS, and proceed as required. If the BTS has only basic
power supply redundancy, the tests and procedures detailed in the
following tables should be bypassed.

� Table 3-48. Miscellaneous Alarm Tests (BTS Frame)

� Table 3-49. BBX Redundancy Tests (BTS Frame)

� Table 3-50. CSM, GPS, & LFR/HSO Redundancy Alarm Tests

� Table 3-51. LPA Redundancy Test

� Table 3-52. MGLI/GLI Redundancy Test

During redundancy verification of the test, alarms reported by the master
GLI (displayed via the alarm monitor) will also be verified/noted.

Test Equipment

The following pieces of test equipment are required to perform this test:

� LMF

� Communications Test Set

Redundancy/Alarm Test

Perform each of the following tests to verify BTS redundancy and to
confirm all alarms are received and reported by the BTS equipment. The
procedures should be performed on the following modules/boards:

� Power supply/converter modules in all frames

� Distribution shelf modules in the BTS frame

� C–CCP shelf modules in the BTS frame (except MCCs)

� LPA modules in the BTS frame

� AMR Customer defined input/output tests

3



BTS Redundancy/Alarm Testing – continued

DRAFT
SC�4812T CDMA BTS Optimization/ATP Mar 20013-86

68P09253A61

Test Equipment Setup

Follow the procedure in Table 3-46 to set up test equipment:

All alarm tests are performed using TX antenna 1

NOTE

Table 3-46: Test Equipment Setup for Redundancy/Alarm Tests

Step Action

1 Interface the LMF computer to the BTS LAN A connector on the BTS frame (refer to Table 3-2,
page 3-5).

2 Login to the BTS.

3 Set up test equipment for TX Calibration at TXOUT1 (see Figure 3-11 or Figure 3-12).

* IMPORTANT
If site is not equipped for redundancy, remove all GLI2 and BBX boards installed in any redundant
slot positions at this time.

4 Display the alarm monitor by selecting Util>Alarm Monitor.

5 Unequip all customer defined AMR alarms reported via the AMR Alarm connector (A & B) by
clicking on MGLI, then selecting Device>Customer Alarm Inputs>Unequipped.

NOTE
During configuration of MGLI alarm reporting, spurious alarms may report. Allow the BTS to
stabilize for 10 seconds. If any alarms are actively being reported after the BTS has stabilized,
determine the cause before proceeding further.
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Power Supply Redundancy

Follow the steps in Table 3-47 to verify redundancy of the power supply
modules. Alarms reported by the master GLI (displayed via the alarm
monitor) are also verified.

Table 3-47: Power Supply/Converter Redundancy (BTS Frame)

Step Action

1 Select the MGLI (highlight) and from the pulldown menu select:

Device>Set Redundant Sector>None/0
Device>Set Pilot>Only>Carrier–#–1-1

Device>Set Pilot>Only>Carrier–#-1-1 and Pilot Gain = 262

2 Select (highlight) BBX–1 and from the pulldown menu select Device>Key XCVR.

3 Set XCVR gain to 40 and enter the correct XCVR channel number.

4 Remove PS–1 from the power distribution shelf (see Figure 3-19).

– Observe that an alarm message is reported via the MGLI as displayed on the alarm monitor.

– Verify no other modules went OOS.

5 Re-install PS–1.

Observe the alarm clears on the alarm monitor.

6 Repeat steps 4 and 5 for PS–2 and PS–3.

NOTE
For +27 V systems, skip to step 7 through step 10.

7 On –48 V systems, remove PS–4 (see Figure 3-20).

– Observe that an alarm message is reported via the MGLI as displayed on the alarm monitor.

– Verify no other modules went OOS.

8 Re-install PS–4.

Observe the alarm clears on the alarm monitor.

9 Repeat steps 7 and 8 for PS–5 through PS–9.

10 Verify that all PWR/ALM LEDs are GREEN.

11 Select BBX-1 and Device>Dekey XCVR
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Miscellaneous
Alarm/Redundancy Tests

Follow the steps in Table 3-48 to verify alarms reported by the master
GLI are displayed via the alarm monitor if a BTS frame module failure
occurs.

Table 3-48: Miscellaneous Alarm Tests

Step Action

1 Select Util>Alarm Monitor to display the alarm monitor window.

2 Perform the following to verify fan module alarms:
• Unseat a fan module (see Figure 3-21 or Figure 3-22).

• Observe an alarm message was reported via the MGLI (as displayed on the alarm monitor).

• Replace fan module and verify the alarm monitor reports that the alarm clears.

• Repeat for all other fan modules in the BTS frame.

NOTE
Follow Step 3 for Starter Frames and Step 4 for Expansion Frames.

3 Starter Frames Only:

Perform the following to verify MPC module alarms.
• Unseat MPC modules (see Figure 3-19) one at a time.

• Observe that an alarm message was reported via the MGLI as displayed on the alarm monitor.

• Replace the MPC modules and verify the alarm monitor reports the alarm clears.

4 Expansion Frames Only:

Perform the following to verify EMPC module alarms.
• Unseat EMPC modules (see Figure 3-19) one at a time

• Observe that an alarm message was reported via the MGLI as displayed on the alarm monitor.

• Replace the EMPC modules and verify the alarm monitor reports that the alarm clears.

5 If equipped with AMR redundancy, perform the following to verify AMR module redundancy/alarms.
• Unseat AMR 2 (see Figure 3-19).

• Observe that an alarm message is reported via the MGLI (as displayed on the alarm monitor).

• Repeat Steps 1 through 3 and/or 4.

• Replace the AMR module and verify the alarm monitor reports that the alarm clears.

• Unseat AMR 1 and observe an alarm message was reported via the MGLI (as displayed on the alarm
monitor).

• Replace the AMR module and verify the LMF reports the alarm has cleared.

NOTE
All PWR/ALM LEDs should be GREEN at the completion of this test.
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Figure 3-21: +27 V BTS C-CCP Fan Modules
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Figure 3-22: –48 V BTS C-CCP and Power Conversion Shelf Fan Modules
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BBX Redundancy

Follow the steps in Table 3-49 to verify redundancy of the BBXs in the
C–CCP shelf. Alarms reported by the master GLI (displayed via the
alarm monitor) are also verified. This test can be repeated for additional
sectors at the customer’s discretion.

Table 3-49: BBX Redundancy Alarms

Step Action

� WARNING
Any BBXs enabled will immediately key-up. Before enabling any BBX, always verify that the TX
output assigned to the BBX is terminated into a 50 W non-radiating RF load! Failure to do so could
result in serious personal injury and/or damage to the equipment.

1 Enable the primary, then the redundant BBX assigned to ANT 1 by selecting the BBX and
Device>Key Xcvr.

2 Observe that primary BBXs key up, and a carrier is present at each respective frequency.

3 Remove the primary BBX.

4 Observe a carrier is still present.
The Redundant BBX is now the active BBX for Antenna 1.

5 Replace the primary BBX and reload the BBX with code and data.

6 Re-enable the primary BBX assigned to ANT 1 and observe that a carrier is present at each respective
frequency.

7 Remove the redundant BBX and observe a carrier is still present.

8 The Primary BBX is now the active BBX for ANT 1.

9 Replace the redundant BBX and reload the BBX with code and data.

10 Re-enable the redundant BBX assigned to ANT 1 and observe that a carrier is present at each
respective frequency:

11 De-key the Xcvr by selecting Device>Dekey Xcvr.

12 Repeat Steps 1 through 11 for additional BBXs/antennas, if equipped.
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CSM, GPS, & LFR/HSO
Redundancy/Alarm Tests

Follow the procedure in Table 3-50 to verify the manual redundancy of
the CSM, GPS, and LFR/HSO boards. Verification of alarms reported is
also covered.

DO NOT perform the procedure in Table 3-50, unless the
site is configured with a LORAN–C or HSO timebase as a
backup for the GPS.

IMPORTANT

*

Table 3-50: CSM, GPS, & LFR/HSO,  Redundancy/Alarm Tests

Step Action

� WARNING
Any BBXs enabled will immediately key-up. Before enabling any BBX, always verify that the TX
output assigned to the BBX is terminated into a 50 W non-radiating RF load! Failure to do so could
result in serious personal injury and/or damage to the equipment.

1 Enable the primary, then the redundant BBXs assigned to ANT 1 by selecting the BBX and
Device>Key Xcvr.

2 Disconnect the GPS antenna cable, located on top of the BTS frame (see Figure 3-23).
This forces the LORAN–C LFR or HSO board timebase to become the CDMA timing source.

3 Observe a CDMA timing reference alarm and source change is reported by the alarm monitor.

4 Allow the LFR/HSO to become the active timing source.

� Verify the BBXs remain keyed and INS.

� Verify no other modules went OOS due to the transfer to LFR/HSO reference.

� Observe the PWR/ALM LEDs on the CSM 1 front panel are steady GREEN.

5 Reconnect the GPS antenna cable.

6 Allow the GPS to become the active timing source.

� Verify the BBXs remain keyed and INS.

� Verify no other modules went OOS due to the transfer back to the GPS reference.

� Observe the PWR/ALM LEDs on CSM 1 are steady GREEN.

7 Disable CSM 1 and enable CSM 2.

� Various CSM source and clock alarms are now reported and the site comes down.

� Alarms clear when the site comes back up.

. . . continued on next page
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Table 3-50: CSM, GPS, & LFR/HSO,  Redundancy/Alarm Tests

Step Action

8 Allow the CSM 2 board to go INS_ACT.

� Verify the BBXs are dekeyed and OOS, and the MCCs are OOS_RAM.

� Verify no other modules went OOS due to the transfer to CSM 2 reference.

� Observe the PWR/ALM LEDs on CSM 2 front panels are steady GREEN.

NOTE
It can take up to 20 minutes for the CSM to re-establish the GPS link and go INS. MCCs go
OOS_RAM.

9 Key BBXs 1 and R and observe a carrier is present.

10 Repeat Steps 2 through 6 to verify CSM source redundancy with CSM 2.

* IMPORTANT
DO NOT ENABLE the redundant CSM.

11 Disable CSM 2 and enable CSM 1.

� Various CSM Source and Clock alarms are reported and the site comes down.

� Alarms clear when the site comes back up.

12 De-key the Xcvr by selecting Device>Dekey Xcvr.

13 Allow the CSM 1 board to go INS_ACT.

� Verify the BBXs are de-keyed and OOS.

� Verify no other modules went OOS due to the transfer to CSM 1 reference.

� Observe PWR/ALM LEDs on the CSM 1 front panels are steady GREEN.

14 Disable the primary and redundant BBXs.
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Figure 3-23: +27 V SC 4812T Starter Frame I/O Plate
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LPA Redundancy Test

Follow the procedure in Table 3-51 to verify redundancy of the LPAs.

First verify there are no BBX channels keyed BEFORE
moving the antenna connection. Failure to do so can result
in serious personal injury and/or equipment damage.

WARNING

Table 3-51: LPA Redundancy Test

Step Action

1 From the pulldown menu select:

Device > Set Redundant Sector > None/0
Device > Set Pilot > Only > Carrier–#–1-1

Device > Set Pilot > Only > Carrier–#-1-1 and Pilot Gain = 262

2 Key-up the BBX assigned to the LPAs associated with the sector under test (gain = 40).

3 Adjust the communications test set spectrum analyzer, as required, to observe the overall carrier
amplitude and IM Shelf and note for reference. These figures will be required later.

NOTE
See Figure 3-13 for test equipment setup, if required.

4 Push-in and release the breaker supplying the 1st LPA of the pair.

NOTE
After power is removed, IM suppression takes a few seconds to settle out while compensating for the
removal of the 1st LPA. The overall gain decreases by approximately 6 dB. The process must be
complete before proceeding.

5 Verify:
• The other LPA module did not go OOS due to the loss of the LPA.

• The overall carrier amplitude is reduced by approximately 6 dB and IM suppression on the analyzer
display remains basically unchanged.

• LPA fault message is reported via the MGLI and displayed on the alarm monitor.

6 Re-apply power to the LPA module and observe the alarm has cleared on the alarm monitor.

NOTE
All PWR/ALM LEDs should be GREEN at completion of test.

7 Repeat Steps 4 through 6 to verify the 2nd LPA of the pair.

8 De-key the BBX.

� WARNING
First verify there are no BBX channels keyed when moving the antenna connection. Failure to do so
can result in serious personal injury and/or equipment damage.

9 Repeat Steps 1 through 8 to verify LPAs assigned to sectors 2 and 3 (if equipped). Move the test cable
on top of the BTS to TX OUT 2 and TX OUT 3 antenna connectors as required.
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MGLI/GLI Redundancy Test

This test can only be performed when the MM path is
established by the MM (not just with LAPD link
connected). Attempting to force the GLIs to “hot swap”
under alarm monitor control, when isolated from the MM,
causes MGLIs to hang up.

CAUTION

Table 3-52: MGLI/GLI Redundancy Test (with MM Connection Established)

Step Action

NOTE
� This test assumes the alarm monitor is NOT connected to the BTS and the T1/E1 span is connected

and communication is established with the MM.

� BOTH GLIs must be INS before continuing.

1 Verify the BBXs are enabled and a CDMA carrier is present.

2 Identify the primary and redundant MGLI pairs.

3 Pull the MGLI that is currently INS–ACT and has cage control.

4 Observe the BBX remains GREEN, and the redundant MGLI is now active.

5 Verify no other modules go OOS due to the transfer of control to the redundant module.

6 Verify that the BBXs are enabled and a CDMA carrier is present.

7 Reinstall the MGLI and have the OMCR/CBSC place it back in-service.

8 Repeat Steps 1 through 7 to verify the other MGLI/GLI board.
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Alarm Test Overview

ALARM connectors provide Customer Defined Alarm Inputs and
Outputs. The customer can connect BTS site alarm input sensors and
output devices to the BTS, thus providing alarm reporting of active
sensors as well controlling output devices.

The SC 4812T is capable of concurrently monitoring 36 input signals
coming into the BTS. These inputs are divided between 2 Alarm
connectors marked ‘ALARM A’ and ‘ALARM B’ located at the top of
the frame (see Figure 3-24). The ALARM A connector is always
functional; ALARM B is functional when an AMR module is equipped
in the AMR 2 slot in the distribution shelf. ALARM A port monitors
input numbers 1 through 18, while ALARM B port monitors input
numbers 19 through 36 (see Figure 3-25). State transitions on these input
lines are reported to the LMF and OMCR as MGLI Input Relay alarms.

ALARM A and ALARM B connectors each provide 18 inputs and 8
outputs. If both A and B are functional, 36 inputs and 16 outputs are
available. They may be configured as redundant. The configuration is set
by the CBSC.

Alarm Reporting Display

The Alarm Monitor window can be displayed to list alarms that occur
after the window is displayed. To access the Alarm Monitor window,
select Util>Alarm Monitor.

The following buttons are included:

� The Options button allows for a severity level (Warning, Minor, and
Major) selection. The default is all levels. To change the level of
alarms reported click on the Options button and highlight the desired
alarm level(s). To select multiple levels press the <Ctrl> key (for
individual selections) or <Shift> key (for a range of selections) while
clicking on the desired levels.

� The Pause button pauses/stops the display of alarms. When the Pause
button is clicked the name of the button changes to Continue. When
the Continue button is clicked, the display of alarms continues.
Alarms that occur between the time the Pause button is clicked and
the Continue button is clicked are not displayed.

� The Clear button clears the Alarm Monitor display. New alarms that
occur after the Clear button is clicked are displayed.

� The Dismiss button dismisses/closes the Alarm Monitor display.

3



BTS Alarms Testing – continued

DRAFT
SC�4812T CDMA BTS Optimization/ATP Mar 20013-98

ÂÂÂÂÂÂ
ÂÂÂÂÂÂ
ÂÂÂÂÂÂ
ÂÂÂÂÂÂ
ÂÂÂÂÂÂ

Á
Á

Á

Á
ÁÁÁ

Á

59

1

60

2

59

1

60

2

Figure 3-24: Alarm Connector Location and Connector Pin Numbering
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Purpose
The following procedures verify the customer defined alarms and relay
contacts are functioning properly. These tests are performed on all AMR
alarms/relays in a sequential manner until all have been verified. Perform
these procedures periodically to ensure the external alarms are reported
properly. Following these procedures ensures continued peak system
performance.

Study the site engineering documents and perform the following tests
only after first verifying that the AMR cabling configuration required to
interconnect the BTS frame with external alarm sensors and/or relays
meet requirements called out in the SC 4812T Series BTS Installation
Manual.

Motorola highly recommends that you read and understand
this procedure in its entirety before starting this procedure.

IMPORTANT

*

Test Equipment
The following test equipment is required to perform these tests:

� LMF
� Alarms Test Box (CGDSCMIS00014) –optional

 . . . continued on next page
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Abbreviations used in the following figures and tables are
defined as:

� NC = normally closed
� NO = normally open
� COM or C = common
� CDO = Customer Defined (Relay) Output
� CDI = Customer Defined (Alarm) Input

NOTE

59 1

60 2

ALARM A
(AMR 1)

ALARM B
(AMR 2)Returns

25

26

A CDI 18 . . . A CDI 1

59 1

60 2

 Returns

25

26

B CDI 36 . . . B CDI 19

FW00302

Figure 3-25: AMR Connector Pin Numbering

The preferred method to verify alarms is to follow the
Alarms Test Box Procedure, Table 3-53. If not using an
Alarm Test Box, follow the procedure listed in Table 3-54.

NOTE

CDI Alarm Input Verification
with Alarms Test Box

Table 3-53 describes how to test the CDI alarm input verification using
the Alarm Test Box. Follow the steps as instructed and compare results
with the LMF display.

It may take a few seconds for alarms to be reported. The
default delay is 5 seconds. Leave the alarms test box
switches in the new position until the alarms have been
reported.

NOTE

Table 3-53: CDI Alarm Input Verification Using the Alarms Test Box

Step Action

1 Connect the LMF to the BTS and log into the BTS.

2 Select the MGLI.

. . . continued on next page
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Table 3-53: CDI Alarm Input Verification Using the Alarms Test Box

Step Action

3 Click on the Device menu.

4 Click on the Customer Alarm Inputs menu item.

5 Click on N.O. Inputs.

A status report window displays the results of the action.

6 Click on the OK button to close the status report window.

7 Set all switches on the alarms test box to the Open position.

8 Connect the alarms test box to the ALARM A connector (see Figure 3-24).

9 Set all of the switches on the alarms test box to the Closed position. An alarm should be reported for
each switch setting.

10 Set all of the switches on the alarms test box to the Open position. A clear alarm should be reported
for each switch setting.

11 Disconnect the alarms test box from the ALARM A connector.

12 Connect the alarms test box to the ALARM B connector.

13 Set all switches on the alarms test box to the Closed position. An alarm should be reported for each
switch setting

14 Set all switches on the alarms test box to the Open position. A clear alarm should be reported for each
switch setting.

15 Disconnect the alarms test box from the ALARM B connector.

16 Select the MGLI.

17 Click on the Device menu.

18 Click on the Customer Alarm Inputs menu item.

19 Click on N.C. Inputs. A status report window displays the results of the action.

20 Click OK to close the status report window.

Alarms should be reported for alarm inputs 1 through 36.

21 Set all switches on the alarms test box to the Closed position.

22 Connect the alarms test box to the ALARM A connector.

Alarms should be reported for alarm inputs 1 through 18.

23 Set all switches on the alarms test box to the Open position.

An alarm should be reported for each switch setting.

24 Set all switches on the alarms test box to the Closed position.

A clear alarm should be reported for each switch setting.

25 Disconnect the alarms test box from the ALARM A connector.

. . . continued on next page
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Table 3-53: CDI Alarm Input Verification Using the Alarms Test Box

Step Action

26 Connect the alarms test box to the ALARM B connector.

A clear alarm should be reported for alarm inputs 19 through 36.

27 Set all switches on the alarms test box to the Open position.

An alarm should be reported for each switch setting.

28 Set all switches on the alarms test box to the Closed position.

A clear alarm should be reported for each switch setting.

29 Disconnect the alarms test box from the ALARM B connector.

30 Select the MGLI.

31 Click on the Device menu.

32 Click on the Customer Alarm Inputs menu item.

33 Click on Unequipped.

A status report window displays the results of the action.

34 Click on the OK button to close the status report window.

35 Connect the alarms test box to the ALARM A connector.

36 Set all switches on the alarms test box to both the Open and the Closed position.

No alarm should be reported for any switch settings.

37 Disconnect the alarms test box from the ALARM A connector.

38 Connect the alarms test box to the ALARM B connector.

39 Set all switches on the alarms test box to both the Open and the Closed position.

No alarm should be reported for any switch settings.

40 Disconnect the alarms test box from the ALARM B connector.

41 Load data to the MGLI to reset the alarm relay conditions according to the CDF file.
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CDI Alarm Input Verification
without Alarms Test Box

Table 3-54 describes how to test the CDI alarm input verification
without the use of the Alarms Test Box. Follow the steps as instructed
and compare results with the LMF display.

It may take a few seconds for alarms to be reported. The
default delay is 5 seconds. When shorting alarm pins wait
for the alarm report before removing the short.

NOTE

Table 3-54: CDI Alarm Input Verification Without the Alarms Test Box

Step Action

1 Connect the LMF to the BTS and log into the BTS.

2 Select the MGLI.

3 Click on the Device menu

4 Click on the Customer Alarm Inputs menu item.

5 Click on N.O. Inputs.

A status report window displays the results of the action.

6 Click on OK to close the status report window.

7 Refer to Figure 3-25 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25–26 through 59–60) together.

An alarm should be reported for each pair of pins that are shorted.

A clear alarm should be reported for each pair of pins when the short is removed.

8 Refer to Figure 3-25 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25–26 through 59–60) together.

An alarm should be reported for each pair of pins that are shorted.

A clear alarm should be reported for each pair of pins when the short is removed.

9 Select the MGLI.

10 Click on the Device menu.

11 Click on the Customer Alarm Inputs menu item.

12 Click on N.C. Inputs.

A status report window displays the results of the action.

13 Click on OK to close the status report window.

Alarms should be reported for alarm inputs 1 through 36.

. . . continued on next page

3



BTS Alarms Testing – continued

Mar 2001 3-103SC�4812T CDMA BTS Optimization/ATP
DRAFT

Table 3-54: CDI Alarm Input Verification Without the Alarms Test Box

Step Action

14 Refer to Figure 3-25 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25–26 through 59–60) together.

A clear alarm should be reported for each pair of pins that are shorted.

An alarm should be reported for each pair of pins when the short is removed.

15 Refer to Figure 3-25 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25–26 through 59–60) together.

A clear alarm should be reported for each pair of pins that are shorted.

An alarm should be reported for each pair of pins when the short is removed.

16 Select the MGLI.

17 Click on the Device menu

18 Click on the Customer Alarm Inputs menu item.

19 Click on Unequipped.

A status report window displays the results of the action.

20 Click on OK to close the status report window.

21 Refer to Figure 3-25 and sequentially short the ALARM A connector CDI 1 through CDI 18 pins
(25–26 through 59–60) together.

No alarms should be displayed.

22 Refer to Figure 3-25 and sequentially short the ALARM B connector CDI 19 through CDI 36 pins
(25–26 through 59–60) together.

No alarms should be displayed.

23 Load data to the MGLI to reset the alarm relay conditions according to the CDF file.

 

Pin and Signal Information for
Alarm Connectors

Table 3-55 lists the pins and signal names for Alarms A and B.

Table 3-55: Pin and Signal Information for Alarm Connectors

ALARM A ALARM B

Pin Signal Name Pin Signal Name Pin Signal Name Pin Signal Name

1 A CDO1 NC 31 Cust Retn 4 1 B CDO9 NC 31 B CDI 22

2 A CDO1 Com 32 A CDI 4 2 B CDO9 Com 32 Cust Retn 22

3 A CDO1 NO 33 Cust Retn 5 3 B CDO9 NO 33 B CDI 23

4 A CDO2 NC 34 A CDI 5 4 B CDO10 NC 34 Cust Retn 23

5 A CDO2 Com 35 Cust Retn 6 5 B CDO10 Com 35 B CDI 24

6 A CDO2 NO 36 A CDI 6 6 B CDO10 NO 36 Cust Retn 24

. . . continued on next page
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Table 3-55: Pin and Signal Information for Alarm Connectors

ALARM A ALARM B

Pin Signal NamePinSignal NamePinSignal NamePinSignal Name

7 A CDO3 NC 37 Cust Retn 7 7 B CDO11 NC 37 B CDI 25

8 A CDO3 Com 38 A CDI 7 8 B CDO11 Com 38 Cust Retn 25

9 A CDO3 NO 39 Cust Retn 8 9 B CDO11 NO 39 B CDI 26

10 A CDO4 NC 40 A CDI 8 10 B CDO12 NC 40 Cust Retn 26

11 A CDO4 Com 41 Cust Retn 9 11 B CDO12 Com 41 B CDI 27

12 A CDO4 NO 42 A CDI 9 12 B CDO12 NO 42 Cust Retn 27

13 A CDO5 NC 43 Cust Retn 10 13 B CDO13 NC 43 B CDI 28

14 A CDO5 Com 44 A CDI 10 14 B CDO13 Com 44 Cust Retn 28

15 A CDO5 NO 45 Cust Retn 11 15 B CDO13 NO 45 B CDI 29

16 A CDO6 NC 46 A CDI 11 16 B CDO14 NC 46 Cust Retn 29

17 A CDO6 Com 47 Cust Retn 12 17 B CDO14 Com 47 B CDI 30

18 A CDO6 NO 48 A CDI 12 18 B CDO14 NO 48 Cust Retn 30

19 A CDO7 NC 49 Cust Retn 13 19 B CDO15 NC 49 B CDI 31

20 A CDO7 Com 50 A CDI 13 20 B CDO15 Com 50 Cust Retn 31

21 A CDO7 NO 51 Cust Retn 14 21 B CDO15 NO 51 B CDI 32

22 A CDO8 NC 52 A CDI 14 22 B CDO16 NC 52 Cust Retn 32

23 A CDO8 Com 53 Cust Retn 15 23 B CDO16 Com 53 B CDI 33

24 A CDO8 NO 54 A CDI 15 24 B CDO16 NO 54 Cust Retn 33

25 Cust Retn 1 55 Cust Retn 16 25 B CDI 19 55 B CDI 34

26 A CDI 1 56 A CDI 16 26 Cust Retn 19 56 Cust Retn 34

27 Cust Retn 2 57 Cust Retn 17 27 B CDI 20 57 B CDI 35

28 A CDI 2 58 A CDI 17 28 Cust Retn 20 58 Cust Retn 35

29 Cust Retn 3 59 Cust Retn 18 29 B CDI 21 (+27 V)

Converter Alarm (–48 V)

59 B CDI 36

30 A CDI 3 60 A CDI 18 30 Cust Retn 21 (+27 V)

Converter Retn (–48V)

60 Cust Retn 36

NOTE
CDO = Customer Defined Output

CDI = Customer Defined Input
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